To order ink or supplies from Dell:

1. Double-click the icon on your desktop.
2. Visit the Dell website, or order Dell printer supplies by phone.

www.dell.com/supplies

For the best service, ensure that you have the Dell printer Service Tag available.

Finding Information
About Your Printer
Understanding the Operator Panel Menus
Loading Paper and Originals
Printing
Printing From a Memory Card or USB Key
Copying
Scanning

Understanding the Software
Wireless Networking
Peer-to-Peer Networking
Maintenance
Troubleshooting
Specifications
Appendix
Licensing Notice

Notes, Notices, and Cautions

NOTE: A NOTE indicates important information that helps you make better use of your printer.

NOTICE: A NOTICE indicates either potential damage to hardware or loss of data and tells you how to avoid the problem.

CAUTION: A CAUTION indicates a potential for property damage, personal injury, or death.

Information in this document is subject to change without notice.
© 2008 Dell Inc. All rights reserved.

Reproduction in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden.

Trademarks used in this text: Dell, the DELL logo, and Dell Ink Management System are trademarks of Dell Inc.; Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries. Windows Vista is either a trademark or a registered trademark of Microsoft Corporation in the United States and/or other countries. Bluetooth is a registered trademark owned by Bluetooth SIG, Inc. and is used by Dell Inc. under license. Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Other trademarks and trade names may be used in this document to refer to either the entities claiming the marks and names or their products. Dell Inc. disclaims any proprietary interest in trademarks and trade names other than its own.

UNITED STATES GOVERNMENT RESTRICTED RIGHTS

This software and documentation are provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 and in applicable FAR provisions: Dell Inc., One Dell Way, Round Rock, Texas, 78682, USA.

Model V305-V305w

March 2008 SRV FX705 Rev. A00
## Finding Information

<table>
<thead>
<tr>
<th>What are you looking for?</th>
<th>Find it here</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to set up my printer</td>
<td>Setting Up Your Printer poster</td>
</tr>
<tr>
<td>How to load printable media into my printer</td>
<td>Owner's Manual</td>
</tr>
<tr>
<td>How to print</td>
<td></td>
</tr>
<tr>
<td>How to care for and maintain my printer</td>
<td></td>
</tr>
<tr>
<td>How to contact Dell™</td>
<td></td>
</tr>
</tbody>
</table>

- Safety information for preparing to operate my printer
- Regulatory information
- Warranty information

- Supported paper type and sizes
- How to select and store print media
- How to load printable media into my printer
- How to configure printer settings
- How to view and print documents and photos from memory cards and USB keys
- How to set up and use printer software
- How to care for and maintain my printer
- How to troubleshoot and solve problems

**NOTE:** Your User's Guide is located on the Drivers and Utilities CD or on the Web at support.dell.com.

- Software and Drivers—Certified drivers for your printer and installers for Dell printer software
- Readme files—Last minute technical changes, or advanced technical reference material for experienced users or technicians

**NOTE:** If you purchased your Dell computer and printer at the...
same time, documentation and drivers for your printer are already installed on your computer.

| How to identify your printer when you use support.dell.com or contact support | Service Tag and Express Code Stickers
| How to find the Express Service Code to direct your call when contacting support | These labels are located on your printer. For more information about their location, see Understanding the Printer Parts.

| Solutions—Troubleshooting hints and tips, frequently asked questions, documentation, driver downloads, and product upgrades | Dell Support Website—support.dell.com
| Upgrades—Upgrade information for components, such as memory, the network cards, and optional equipment | NOTE: Select your region or business segment to view the appropriate support site.
| Customer Care—Contact information, service call and order status, warranty, and repair information |

| Supplies for my printer | Dell Printer Supplies Website—www.dell.com/supplies
| Accessories for my printer | You can purchase printer supplies online, by phone, or in select retail stores.
| Replacement ink and parts for my printer |
Understanding the Software

- Using the Dell Imaging Toolbox
- Using Printing Preferences
- Using the Dell Service Center
- Dell Ink Management System
- Using Memory Card Manager
- Removing and Reinstalling Software
- Installing the Adobe® Photoshop® Album Manually
- Installing the Optional XPS Driver

The printer software includes:

- **Dell Imaging Toolbox**— Allows you to perform various scan, copy, and print operations with newly scanned and previously saved documents and images.

- **Printing Preferences**— Allows you to adjust printer settings.

- **Dell Service Center**— Provides step-by-step troubleshooting help, maintenance tasks, and customer support.

- **Dell Ink Management System™**— Warns you when your printer is running low on ink.

- **Adobe® Photoshop® Album Starter Edition**— Allows you to view, manage, and edit photos stored on your computer.

Using the Dell Imaging Toolbox

![Dell Imaging Toolbox](image)

The **Dell Imaging Toolbox** allows you to:

- Scan, copy, and use a variety of tools for your printing needs.

- Select the quantity and quality of your copies.
• Preview images you want to print, scan, or copy.
• Manage photos in a digital photo album.
• E-mail scanned documents and photos.
• Check ink levels.
• Order supplies online.

To access the **Dell Imaging Toolbox**:

1. **In Windows Vista™:**
   a. Click ® **Programs**.
   b. Click **Dell Printers**.
   c. Click **Dell V305**.

   **In Windows® XP and Windows 2000:**
   Click **Start® Programs** or **All Programs® Dell Printers® Dell V305**.

2. Select **Dell Imaging Toolbox**.

   The **Dell Imaging Toolbox** dialog box opens.

The Dell Imaging Toolbox Home screen has the following sections:

<table>
<thead>
<tr>
<th>From this section:</th>
<th>Click:</th>
<th>To:</th>
</tr>
</thead>
</table>
| Your Scanner       | Scan   | • Initiate a scan job.  
                     |        | • Select the program where you want to send the scanned image.  
                     |        | • Select the type of image being scanned.  
                     |        | • Select a quality setting for your scan.  |
| Copy               |        | • Create copies  
                     |        | • Select the quality and color of your copies.  
                     |        | • Select a quality setting for your copies.  
                     |        | • Specify the blank paper size.  
                     |        | • Specify the size of the original document being copied.  
                     |        | • Lighten or darken your copies (this can also be accomplished using the operator panel).  
                     |        | • Resize your copies.  |
| Photos             | My Photo Album | • Manage saved photos in a photo album.  
                     |        | • Print saved photos.  
                     |        | • Create photo greeting cards.  
                     |        | • Create posters from saved photos.  
                     |        | • Attach a saved photo to e-mail messages.  
                     |        | • Convert saved photos to PDF.  |
| Activities         |        | • Resize an image.  
                     |        | • Edit pictures.  
                     |        | • Scan multiple photos.  
                     |        | • Convert a scanned document to text using OCR.  
                     |        | • Scan multiple images into a single file.  
                     |        | • Print an image as a multi-page poster.  
                     |        | • Print borderless photos.  |
| Scan Multiple      |        | Scan several photos at one time, and save them as individual files.  |
For more information, click the Help icon in the Dell Imaging Toolbox.

### Using Printing Preferences

You can change your printer settings in Printing Preferences depending on the type of project you want to create.

To access Printing Preferences when a document is open:

1. Click File® Print.
   
The Print dialog box opens.

2. Click Preferences, Properties, Options, or Setup (depending on the program or operating system).
   
The Printing Preferences dialog box opens.

To access Printing Preferences when a document is not open:

1. In Windows Vista:
   
   a. Click Control Panel.

   b. Click Hardware and Sound.

   c. Click Printers.

   In Windows XP, click Start® Settings® Control Panel® Printers and Other Hardware® Printers and Faxes.

   In Windows 2000, click Start® Settings® Printers.

2. Right-click the Dell V305 icon.

3. Click Printing Preferences.
The Printing Preferences dialog box has three sections:

### Print Setup Tab
- **Quality/Speed** — Select Draft, Normal, or Photo depending on your desired output quality. Draft is the fastest option but should not be selected if you have a photo cartridge installed.
- **Media Type** — Allows you to set the paper type manually, or have the printer detect the paper type automatically.
- **Paper Size** — Select the size of your paper.
- **Print in black and white** — Print your color images in black and white to save the ink in your color cartridge.
  - **NOTE:** You cannot select this setting if you have selected Use Color Cartridge for all Black Printing.
- **Borderless** — Select the check box if you want to print borderless photos.
- **Orientation** — Select how the document is arranged on the printed page. You can print using portrait or landscape orientation.
- **Envelope** — Select the check box if you want to print an envelope. The Paper Size area lists the envelope sizes available for printing.
- **Copies** — Customize how the printer prints several copies of a single print job: Collated, Normal, or Print Last Page First.

### Advanced Tab
- **2-sided Printing** — Select this to print on both sides of the paper, and whether or not to print an instruction page to assist in reloading paper.
- **Layout** — Select from Normal, Banner, Mirror, N-up, Poster, Booklet, or Borderless.
- **Automatic Image Sharpening** — Automatically select the best image-sharpening level based on image content.
- **Dell Customer Experience Improvement Program** — Allows you to access information about, and change your status in, the Dell Customer Experience Improvement Program.
- **More Options** — Allows you to specify Appearance Mode and Complete-A-Print settings. You can also view the paper type that the printer detects.

### Maintenance Tab
- **Install Ink Cartridges**
- **Clean Ink Cartridges**
- **Align Ink Cartridges**
- **Print a Test Page**
- **Network Support**

### Using the Dell Service Center
The Dell Service Center is a diagnostic tool that provides step-by-step troubleshooting help with problems encountered while using the printer. It also contains links to printer maintenance tasks and customer support.

To access the Dell Service Center, you can use either of these methods.

**From an error message dialog box:**

Click the For additional assistance, use the Dell Service Center link.

**From the Start Menu:**

1. In Windows Vista:
   a. Click Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   In Windows XP and Windows 2000:
   Click Start ® Programs or All Programs ® Dell Printers ® Dell V305.

2. Click Dell Service Center.

The Dell Service Center dialog box opens.

---

**Dell Ink Management System**

Each time you print a job, a printing progress screen appears, which shows the progress of the print job as well as the amount of ink remaining and the approximate number of pages remaining in the cartridge. The page counter is hidden during the first 50 pages of cartridge use, until printing habits are learned and a more accurate count can be given. The number of pages remaining changes as a result of the type of print jobs the printer completes.

When your ink cartridge levels are low, a Low Ink Warning appears on your screen when you try to print. This warning is displayed every time you print until you install a new ink cartridge. For more information, see Replacing Ink Cartridges.

When one or both of your ink cartridges are empty, the Reserve Tank window appears on your screen when you try to print. If you continue printing, the print job may not print as you expect.

If your black ink cartridge is out of ink, you can choose to print black from the color ink cartridge (Process Black) by selecting Complete-A-Print before clicking the Continue Printing button. If you select Complete-A-Print and click Continue Printing, Process Black is used for all black printing until the black cartridge is replaced, or the option is cleared from More Options, located on the Advanced tab of the Printing Preferences. The Reserve Tank dialog does not display again until after the low ink cartridge has been replaced. The Complete-A-Print check box is automatically reset when a new or different cartridge is installed.

If your color ink cartridge is out of ink, you can choose to print color documents in grayscale by selecting Complete-A-Print before clicking the Continue Printing button. If you select Complete-A-Print, and click Continue Printing, all
color documents will print in black and white until the color cartridge is replaced or the option is cleared from **More Options**, located on the **Advanced** tab of the **Printing Preferences**. The **Reserve Tank** dialog does not display after the low ink cartridge has been replaced. The **Complete-A-Print** check box is automatically reset when a new or different cartridge is installed.

To adjust Complete-A-Print settings:

1. Click the **Advanced** tab.

2. Click **More Options**.

3. In the Complete-A-Print section, select either **Use color cartridge for all black printing**, or **Use black cartridge to print in black and white** to turn these features on or off.

4. Click **OK**.

---

### Using Memory Card Manager

Memory Card Manager allows you to display, manage, edit, print, and save photos from your memory card or USB memory key to your computer.

To launch Memory Card Manager:
1. Insert a memory card into the memory card slot or a USB key into the PictBridge port on the front of the printer.

**NOTICE:** Do not remove the memory card or USB key, or touch the printer near the area of the memory card or USB key while actively reading, writing, or printing from these devices. Data corruption can occur.

2. *In Windows Vista:*
   a. Click ® Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   *In Windows XP and 2000:*
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

3. Select Activate Memory Card Manager.

---

**Removing and Reinstalling Software**

If your printer does not function properly, or communication error messages appear when using your printer, you can remove and reinstall the printer software.

1. *In Windows Vista:*
   a. Click ® Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   *In Windows XP and Windows 2000:*
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

2. Click Uninstall Dell V305.

3. Follow the instructions on the screen.

4. Restart your computer.

5. Insert the Drivers and Utilities CD, and then follow the instructions on the screen.

   If the installation screen does not appear:
   a. *In Windows Vista,* click ® Computer.

      *In Windows XP,* click Start® My Computer.

      *In Windows 2000,* double-click My Computer from your desktop.

   b. Double-click the CD-ROM drive icon, and then double-click setup.exe.

   c. When the printer software installation screen appears, click Using a USB cable or Using a wireless network.

   d. Follow the instructions on your screen to complete the installation.
Installing the Adobe® Photoshop® Album Manually

1. Insert the Drivers and Utilities CD.

2. In Windows Vista, click ® Computer.
   In Windows XP, click Start® My Computer.
   In Windows 2000, double-click My Computer from your desktop.

3. Double-click the CD-ROM drive icon, and then double-click the Adobe folder.


5. Follow the instructions on your screen to complete the installation.

Installing the Optional XPS Driver

The XML Paper Specification (XPS) driver is an optional printer driver designed to make use of the advanced XPS color and graphics features that are only available for Windows Vista users. In order to use XPS features, you must install the XPS driver as an additional driver after you install your printer.

**NOTE:** Before installing the XPS driver, complete the steps on the Setting Up Your Printer poster to install the printer on your computer.

**NOTE:** Before installing the XPS driver, you must install the Microsoft QFE Patch and extract the driver files from the Drivers and Utilities CD. To install the patch, you must have administrator privileges on the computer.

To install the Microsoft QFE Patch and extract the driver:

1. Insert the Drivers and Utilities CD, and then click Cancel when the Setup Wizard appears.

2. Click ® Computer.

3. Double-click the CD-ROM drive icon, and then double-click Drivers.

4. Double-click xps, and then double-click setupxps.
   XPS driver files are copied to your computer, and any required Microsoft XPS files are launched. Follow the instructions on the screen to finish installing the patch.

To install the driver:

1. Click ® Control Panel.

2. Under Hardware and Sound, click Printer, and then click Add a Printer.

3. From the Add Printer dialog box, choose one of the following:
   • If you are using a USB connection, make sure the USB cable is connected to the computer and printer, and then do the following:
     a. Click Add a local printer.
     b. From the Use an existing port: drop-down menu, select Virtual printer port for USB, and then click Next.
   • If you are using an Ethernet or wireless connection, make sure the printer is connected to the network, and then do the following:
     a. Click Add a network, wireless or Bluetooth printer.
b. Select your printer from the list.

c. If your printer is not in the list, click The printer that I want isn't listed.

d. Select Add a printer using a TCP/IP address or hostname, and then click Next.

e. To locate your printer IP address, print a Network Setup Page from the Network Setup menu under the Setup menu on the printer.

f. Type your printer IP address in the Hostname or IP address: box, and then click Next.

4. Click Have disk.

The Install From Disk dialog box opens.

5. Click Browse, and then navigate to the XPS driver files on your computer:

   a. Click Computer, and then double-click (C:).

   b. Double-click Drivers, and then double-click PRINTER.

   c. Double-click the folder that has your printer model number, and then double-click Drivers.

   d. Double-click xps, and then click Open.

   e. From the Install From Disk dialog box, click OK.

6. Click Next on the following two dialog boxes.

For more information on the XPS driver, see the XPS readme file on the Drivers and Utilities CD. The file is located in the xps folder with the setupxps batch file (D:\Drivers\xps\readme).
About Your Printer

- **Understanding the Printer Parts**
- **Understanding the Operator Panel**

### Understanding the Printer Parts

<table>
<thead>
<tr>
<th>Number</th>
<th>Part:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Paper support</td>
<td>Part that supports loaded paper.</td>
</tr>
<tr>
<td>2</td>
<td>Paper guide</td>
<td>Guide that helps the paper feed into the printer properly.</td>
</tr>
<tr>
<td>3</td>
<td>Foreign object guard</td>
<td>Part that prevents small foreign objects from falling into the paper path.</td>
</tr>
<tr>
<td>4</td>
<td>Top cover</td>
<td>Top of printer that holds your document or photo flat while you scan it.</td>
</tr>
<tr>
<td>5</td>
<td>Paper exit tray</td>
<td>Tray that holds the paper as it exits the printer.</td>
</tr>
<tr>
<td>6</td>
<td>Scanner base unit</td>
<td>Unit you lift to gain access to the ink cartridges.</td>
</tr>
<tr>
<td>7</td>
<td>Ink cartridge carrier</td>
<td>Carrier that holds two ink cartridges, one color and the other black or photo. For more information, see <a href="#">Replacing Ink Cartridges</a>.</td>
</tr>
<tr>
<td>8</td>
<td>Supplies Reorder Label</td>
<td>To order ink cartridges or paper, visit <a href="http://www.dell.com/supplies">www.dell.com/supplies</a>.</td>
</tr>
<tr>
<td>9</td>
<td>Memory card slots</td>
<td>Slots into which you insert a memory card containing digital photos.</td>
</tr>
</tbody>
</table>
| 10     | Express Service Code and Service Tag number | - Identify your printer when you use [support.dell.com](http://support.dell.com) or contact technical support.  
          |                                      | - Enter the Express Service Code to direct your call when contacting technical support.  
          |                                      | **NOTE:** The Express Service Code is not available in all countries.        |
| 11     | MAC address label                    | Identify the media access control (MAC) address of the printer.             |
|        |                                      | **NOTE:** Your printer model may not have wireless capability and may not have this label. |
### Understanding the Operator Panel

<table>
<thead>
<tr>
<th>Number</th>
<th>Part:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Dell Internal Network Adapter</td>
<td>A networking device to set up your printer on a wireless network.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Your printer model may not have wireless capability and may not have this device.</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Power connector</td>
<td>Slot into which you plug the power cable.</td>
</tr>
<tr>
<td></td>
<td><strong>CAUTION:</strong> Insert the power cable into the printer before connecting the power cable into the wall outlet.</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>USB connector</td>
<td>Slot into which you plug the USB cable (sold separately). The other end of the USB cable plugs into your computer.</td>
</tr>
<tr>
<td>15</td>
<td>PictBridge port</td>
<td>The port into which you attach the connector of a PictBridge-enabled digital camera, Bluetooth™ adapter, or a USB key.</td>
</tr>
<tr>
<td>16</td>
<td>Operator panel</td>
<td>Panel on the printer you use to control copying, scanning, and printing. For more information, see Understanding the Operator Panel.</td>
</tr>
<tr>
<td>17</td>
<td>Scanner glass</td>
<td>Surface on which you place your document or photo face down to copy or scan it.</td>
</tr>
<tr>
<td>Number</td>
<td>Use the:</td>
<td>To:</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>-----</td>
</tr>
<tr>
<td>1</td>
<td>Display</td>
<td>View scanning, copying, and printing options as well as status and error messages.</td>
</tr>
<tr>
<td>2</td>
<td>Arrow buttons</td>
<td></td>
</tr>
</tbody>
</table>
  - Scroll through modes, menus, and menu items.  
  - Increase or decrease a numeric value option.  
  - Scroll through photos and Microsoft® Office files on a memory card or digital camera. |
| 3      | Back button | Return to the previous menu. |
| 4      | Select button |  
  - Access the currently displayed menu.  
  - Select a menu option.  
  - Initiate a paper feed or paper eject by holding the button for three seconds. |
| 5      | Power button | Turn your printer on or off.  
  **NOTE:** Pressing the power button does not turn off your printer if a PictBridge camera with an active session is inserted into the PictBridge port. |
| 6      | Cancel button |  
  - Cancel a scan, print, or copy job in progress.  
  - Exit a menu without saving changes to the menu settings. |
| 7      | Start button | Initiate a copy or scan. |
| 8      | Error LED | Check if there is an error. |
| 9      | Wi-Fi LED | Check if Wi-Fi is activated:  
  - **Off** indicates that the printer is not turned on.  
  - **Orange** indicates that the printer is ready for wireless connection, but not connected.  
  - **Orange blinking** indicates that the printer is configured but unable to communicate with the wireless network.  
  - **Blue** indicates that the printer is connected to a wireless network. |
Wireless Networking

- Minimum Requirements for Setup
- Wireless Network Settings
- Wireless Encryption
- Using USB Cable to Configure the Printer on a Wireless Network (recommended for most users)
- Using Wi-Fi Protected Setup to Configure the Printer on a Wireless Network (for advanced users only)
- Changing Wireless Settings after Installation

Minimum Requirements for Setup

**NOTE:** This section is applicable only to the Dell V305w printer, which is equipped with a wireless adapter.

**NOTE:** For more wireless information, see your router’s Operation Manual or contact your router manufacturer’s helpline or your broadband service provider.

- The Dell™ Printer
- An existing wireless network
- The *Drivers and Utilities* CD that shipped with your printer
- A computer running one of the following operating systems:
  - Windows Vista™
  - Microsoft® Windows® XP
  - Microsoft Windows 2000

Wireless Network Settings

Some wireless network settings may be needed to configure the adapter that has been installed in the printer. Here are some of the settings that you may need:

- Network Name, also known as SSID (Service Set ID)
- BSS (Basic Service Set) Type (the type of wireless network you use—Ad-Hoc or Infrastructure)
- Wireless Channel Number
- Network Authentication and encryption type
- Security Key(s)

Wireless Encryption

The following security types are supported:
- No security
- WEP with either 64-bit or 128-bit key
- WPA with 128-bit TKIP encryption engine
- WPA2 with 128-bit AES-CCMP encryption engine

A WPA (WiFi Protected Access) pre-shared key is like a password and must meet the following criteria:

- If you are using Hexadecimal characters, valid keys are 64 characters long.
- If you are using ASCII, valid keys are at least 8 characters long.

The wireless network may use anywhere from one to four WEP keys. A WEP key is like a password and must meet the following criteria:

- If you are using Hexadecimal characters, valid keys are either 10 or 26 characters long.
- If you are using ASCII, valid keys are either 5 or 13 characters long.

---

**Using USB Cable to Configure the Printer on a Wireless Network (recommended for most users)**

Before configuring the printer on a wireless network, ensure that:

- Your wireless network is set up and working properly.
- The computer you are using is connected to the same wireless network where you want to set up the printer.

1. **If you are using your printer with a new Dell computer**: Connect the USB cable between the port on the back of the printer and the port on the back of the computer. Go to step 5.

   *If you are using your printer with an existing computer*: Go to the next step.

2. Ensure that your computer is on, and then insert the Drivers and Utilities CD.

3. From the Welcome screen, click Next.

4. Select I Agree to the terms of this license agreement, and then click Next.

5. From the Select Connection Type screen, select Wireless Connection.

6. Click Next.

7. Follow the instructions on your screen to complete setup.

---

**Using Wi-Fi Protected Setup to Configure the Printer on a Wireless Network (for advanced users only)**

Wi-Fi Protected Setup (WPS) is only available if you are using a WPS-enabled router. If you are not sure if your router is WPS-enabled, check the router for the WPS logo.

Before beginning WPS-enabled setup, you must know the router IP address. If you are unsure of the router IP address,
follow the instructions for Using USB Cable to Configure the Printer on a Wireless Network (recommended for most users).

NOTE: If your wireless network security is disabled, make sure to enable the security settings before proceeding with WPS configuration. (Consult your wireless router manufacturer’s documentation.) If you do not enable your wireless network security, configuring your printer using WPS may change your wireless network settings. You will then be required to reconnect your computer to your router with your new wireless network settings.

Using the PIN Method

1. If you are using your printer with a new Dell computer: Connect the USB cable between the port on the back of the printer and the port on the back of the computer. Go to step 5.

   If you are using your printer with an existing computer: Go to the next step.

2. Ensure that your computer is on, and then insert the Drivers and Utilities CD.

3. From the Welcome screen, click Next.

4. Select I Agree to the terms of this license agreement, and then click Next.

5. From the Select Connection Type screen, select Wireless Connection, and then click Next.

6. Wait until the Configure Wireless screen appears.

7. Using an Internet browser, type in your router IP address and press Enter. Navigate to the WPS Webpage.

   NOTE: You may be prompted to enter your username and password. If you are not sure of the username and password, contact your router manufacturer’s helpline or your Internet service provider.

8. On your printer operator panel, use the left or right arrow button to scroll to Setup, and then press the Select button.

9. Use the left or right arrow button to scroll to Network Setup, and then press the Select button.
10. Use the left or right arrow button ⬅️ ➚ to scroll to Wi-Fi Protected Setup, and then press the Select button.

11. Use the left or right arrow button ⬅️ ➚ to scroll to PIN, and then press the Select button.

12. Press the Select button to continue.

13. Type the PIN provided on your printer operator panel into the PIN field on your router WPS page within two minutes.

   If setup is successful, Wi-Fi Protected Setup Successful appears on the printer operator panel.

   Check if the printer’s Wi-Fi LED turns blue. For more information, see Wi-Fi LED. Continue with step 14.

   If setup is not successful or times out, perform step 8 to step 13 again.

14. Close the router WPS page.

15. Follow the instructions on the installation screen to complete setup.

Using the Push Button Method

1. If you are using your printer with a new Dell computer: Connect the USB cable between the port on the back of the printer and the port on the back of the computer. Go to step 5.

   If you are using your printer with an existing computer: Go to the next step.

2. Ensure that your computer is on, and then insert the Drivers and Utilities CD.
3. From the **Welcome** screen, click **Next**.

4. Select **I Agree to the terms of this license agreement**, and then click **Next**.

5. From the **Select Connection Type** screen, select **Wireless Connection**, and then click **Next**.

6. Wait until the **Configure Wireless** screen appears.

![Configure Wireless Image]

7. Using an Internet browser, type in your router IP address, and press **Enter**. Navigate to the WPS Webpage.

![Internet Browser Image]

**NOTE:** You may be prompted to enter your username and password. If you are not sure of the username and password, contact your router manufacturer's helpline or your Internet service provider.

8. On your printer operator panel, use the left or right arrow button ▶️ to scroll to **Setup**, and then press the **Select** button ⏤.

9. Use the left or right arrow button ▶️ to scroll to **Network Setup**, and then press the **Select** button ⏤.

10. Use the left or right arrow button ▶️ to scroll to **Wi-Fi Protected Setup**, and then press the **Select** button ⏤.

11. Use the left or right arrow button ▶️ to scroll to **Push Button**, and then press the **Select** button ⏤.

12. Press the **Select** button ⏤ to continue.
13. Click **Push Button** on your router WPS page within two minutes.

   If setup is successful, **Wi-Fi Protected Setup Successful** appears on the printer operator panel.

   Check if the printer's Wi-Fi LED turns blue. For more information, see **Wi-Fi LED**. Continue with **step 14**.

   If setup is not successful or times out, perform **step 8** to **step 13** again.

14. Close the router WPS page.

15. Follow the instructions on the installation screen to complete setup.

---

**Using Windows Vista**

To configure your printer on the wireless network using WPS, you may use Windows Vista™ instead of the Push-Button or PIN methods. For more information about using Windows Vista, see the documentation that came with your operating system.

---

**Changing Wireless Settings after Installation**

Configuring the printer using the Wireless Setup Utility involves connecting the wireless printer to a computer by USB cable, and launching the **Drivers and Utilities** CD.

If you need to adjust the wireless adapter settings after installation, the CD is not required. Launch the Wireless Setup Utility.

**In Windows Vista:**

1. Click ® **Programs**.
2. Click **Dell Printers**.

3. Click **Dell V305**.

4. Click **Dell Wireless Setup Utility**.

5. Follow the instructions on your screen to change wireless settings.

*In Windows XP and Windows 2000:*

1. Click **Start**® Programs or All Programs® Dell Printers® Dell V305.

2. Click **Dell Wireless Setup Utility**.

3. Follow the instructions on your screen to change wireless settings.

The Wireless Setup Utility steps you through the configuration process. The wizard can automatically detect wireless network settings or allow you to manually enter the network configuration settings.
Understanding the Operator Panel Menus

- **Copy Mode**
- **Scan Mode**
- **Photo Mode**
- **PictBridge Mode**
- **Office File Mode**
- **Bluetooth Mode**
- **Setup Mode**
- **Maintenance Mode**

When you press the **Arrow** buttons < >, the following modes appear. When the mode you want to use is displayed, press the **Start** button to access its menus.

---

### Copy Mode

<table>
<thead>
<tr>
<th>Main Menu</th>
<th>Mode Main Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copy Color</td>
</tr>
<tr>
<td></td>
<td>Copies</td>
</tr>
<tr>
<td></td>
<td>Quality</td>
</tr>
<tr>
<td></td>
<td>Dark</td>
</tr>
<tr>
<td></td>
<td>Paper Setup</td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
</tr>
<tr>
<td></td>
<td>Repeat Image</td>
</tr>
<tr>
<td></td>
<td>Collate</td>
</tr>
<tr>
<td></td>
<td>N-Up</td>
</tr>
<tr>
<td></td>
<td>Original Size</td>
</tr>
<tr>
<td></td>
<td>Original Type</td>
</tr>
<tr>
<td></td>
<td>ID Card Copy</td>
</tr>
</tbody>
</table>

To view or change the Copy Mode menu settings:

1. From the main menu, use the left and right **Arrow** buttons < > to scroll to **COPY**.

2. Press the **Select** button ☑.

3. Use the left and right **Arrow** buttons < > until the heading you want appears on the display, and then press the **Select** button ☑.

4. Use the left and right **Arrow** buttons < > to scroll through the available menu items.

5. When the setting you want appears on the display, press the **Select** button ☑ to save the setting.
<table>
<thead>
<tr>
<th>Copy Color</th>
<th>*Color</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Black</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Copies</th>
<th>1–99</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Quality</th>
<th>*Automatic</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Draft</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>Photo</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dark</th>
<th>Press the Select button and then use the left and right Arrow buttons to adjust the brightness setting.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Paper Setup</th>
<th>Paper Size</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Paper Type</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Zoom</th>
<th>50%</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>*100%</td>
</tr>
<tr>
<td></td>
<td>150%</td>
</tr>
<tr>
<td></td>
<td>200%</td>
</tr>
<tr>
<td></td>
<td>Custom %</td>
</tr>
<tr>
<td></td>
<td>Fit to Page</td>
</tr>
<tr>
<td></td>
<td>2 x 2 Poster</td>
</tr>
<tr>
<td></td>
<td>3 x 3 Poster</td>
</tr>
<tr>
<td></td>
<td>4 x 4 Poster</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Repeat Image</th>
<th>*1 Per Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>4 Per Page</td>
</tr>
<tr>
<td></td>
<td>9 Per Page</td>
</tr>
<tr>
<td></td>
<td>16 Per Page</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Collate</th>
<th>*Off</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>On</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>N-Up</th>
<th>*1 Up</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2 Up</td>
</tr>
<tr>
<td></td>
<td>4 Up</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Original Size</th>
<th>*Automatic</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>8.5 x 11 in.</td>
</tr>
<tr>
<td></td>
<td>2.25 x 3.25</td>
</tr>
<tr>
<td></td>
<td>3 x 5 in.</td>
</tr>
<tr>
<td></td>
<td>3.5 x 5 in.</td>
</tr>
<tr>
<td></td>
<td>4 x 6 in.</td>
</tr>
<tr>
<td></td>
<td>4 x 8 in.</td>
</tr>
<tr>
<td></td>
<td>5 x 7 in.</td>
</tr>
<tr>
<td></td>
<td>8 x 10 in.</td>
</tr>
<tr>
<td></td>
<td>L</td>
</tr>
<tr>
<td></td>
<td>2L</td>
</tr>
<tr>
<td></td>
<td>Hagaki</td>
</tr>
<tr>
<td></td>
<td>A6</td>
</tr>
<tr>
<td></td>
<td>A5</td>
</tr>
<tr>
<td></td>
<td>B5</td>
</tr>
<tr>
<td></td>
<td>A4</td>
</tr>
<tr>
<td></td>
<td>60x80 mm</td>
</tr>
<tr>
<td></td>
<td>9x13 cm</td>
</tr>
<tr>
<td></td>
<td>10x15 cm</td>
</tr>
<tr>
<td></td>
<td>10x20 cm</td>
</tr>
<tr>
<td></td>
<td>13x18 cm</td>
</tr>
<tr>
<td></td>
<td>20x25 cm</td>
</tr>
</tbody>
</table>
Scan Mode

The Scan Mode menu is only available if the printer is connected to a computer or a network adapter.

<table>
<thead>
<tr>
<th>Main Menu</th>
<th>Mode Main Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan</td>
<td>Scan Color</td>
</tr>
<tr>
<td></td>
<td>Scan To Computer</td>
</tr>
<tr>
<td></td>
<td>Scan To Network</td>
</tr>
<tr>
<td></td>
<td>Scan To Memory Device</td>
</tr>
<tr>
<td></td>
<td>Quality</td>
</tr>
<tr>
<td></td>
<td>Original Size</td>
</tr>
</tbody>
</table>

To view or change the Scan Mode menu settings:

1. From the main menu, use the left and right Arrow buttons to scroll to Scan.

2. Press the Select button.

3. Use the left and right Arrow buttons until the heading you want appears on the display, and then press the Select button.

4. Use the left and right Arrow buttons to scroll through the available menu items.

5. When the setting you want appears on the display, press the Select button to save the setting.

<table>
<thead>
<tr>
<th>Scan menu item</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Color</td>
<td>*Color, Black</td>
</tr>
<tr>
<td>Scan To Computer</td>
<td>App List</td>
</tr>
<tr>
<td>Scan To Network</td>
<td>PC Name</td>
</tr>
<tr>
<td>Scan To Memory Device</td>
<td>Place document on scanner, and press the right Arrow button.</td>
</tr>
<tr>
<td>Quality</td>
<td>*Automatic, 75 dpi, 150 dpi, 300 dpi, 600 dpi, 1200 dpi</td>
</tr>
<tr>
<td>Original Size</td>
<td></td>
</tr>
</tbody>
</table>
Photo Mode

Photo Mode is only available when a memory card is inserted into the printer, or if a USB key or a PictBridge-enabled digital camera is connected to the PictBridge port.

<table>
<thead>
<tr>
<th>Main Menu</th>
<th>Mode Main Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo</td>
<td>Proof Sheet</td>
</tr>
<tr>
<td>Print DPOF</td>
<td>Auto Enhance</td>
</tr>
<tr>
<td>Photo Color</td>
<td>Save To</td>
</tr>
<tr>
<td>Auto Enhance</td>
<td>Print Images</td>
</tr>
<tr>
<td>Save To</td>
<td>Photo Size</td>
</tr>
<tr>
<td>Print Images</td>
<td>Quality</td>
</tr>
</tbody>
</table>

To view or change the Photo Mode menu settings:

1. Insert a memory card into the card slots or a USB key into the PictBridge port.

 NOTICE: Do not remove the memory card or USB key, or touch the printer near the area of the memory card or USB key while actively reading, writing, or printing from these devices. Data corruption can occur.

2. If the memory card or USB key contains photo files only, the display automatically changes to PHOTO. Use the left and right Arrow buttons < > until the heading you want appears on the display, and then press the Select button.

   If the memory card or USB key contains both documents and photos, the printer asks which files to print. Use the left and right Arrow buttons < > to scroll to Photos, and then press the Select button.

3. Use the left and right Arrow buttons < > to scroll through the available menu items.

4. When the setting you want appears on the display, press the Select button to save the setting.
PictBridge Mode

Your printer automatically switches to PictBridge mode when you connect a PictBridge-enabled camera. You can print pictures using the controls of the camera.

<table>
<thead>
<tr>
<th>Photo menu item</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proof Sheet</td>
<td>• Print Proof Sheet</td>
</tr>
<tr>
<td></td>
<td>• Scan Proof Sheet</td>
</tr>
<tr>
<td>Print DPOF</td>
<td>Press the Start button to print all DPOF images on a memory card. For more information, see Printing Photos From a PictBridge-Enabled Camera.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> This menu item is only available when a memory card with Digital Print Order Format (DPOF) images is inserted into the printer or when a PictBridge-enabled digital camera with DPOF images is connected to the PictBridge port.</td>
<td></td>
</tr>
<tr>
<td>Photo Color</td>
<td>• *Color</td>
</tr>
<tr>
<td></td>
<td>• Black &amp; White</td>
</tr>
<tr>
<td></td>
<td>• Sepia</td>
</tr>
<tr>
<td>Auto Enhance</td>
<td>• *Off</td>
</tr>
<tr>
<td></td>
<td>• On</td>
</tr>
<tr>
<td>Save To</td>
<td>• Computer</td>
</tr>
<tr>
<td></td>
<td>• Network</td>
</tr>
<tr>
<td>Print Images</td>
<td>Press the Select button to print all images stored on a memory card, USB key, or a PictBridge-enabled digital camera.</td>
</tr>
<tr>
<td>Photo Size</td>
<td>• *4 x 6 in.</td>
</tr>
<tr>
<td></td>
<td>• 5 x 7 in.</td>
</tr>
<tr>
<td></td>
<td>• 8 x 10 in.</td>
</tr>
<tr>
<td></td>
<td>• L</td>
</tr>
<tr>
<td></td>
<td>• 2L</td>
</tr>
<tr>
<td></td>
<td>• 6 x 8 cm</td>
</tr>
<tr>
<td></td>
<td>• 10 x 15 cm</td>
</tr>
<tr>
<td></td>
<td>• 13 x 18 cm</td>
</tr>
<tr>
<td></td>
<td>• 8.5 x 11 in.</td>
</tr>
<tr>
<td></td>
<td>• A4</td>
</tr>
<tr>
<td></td>
<td>• A5</td>
</tr>
<tr>
<td></td>
<td>• B5</td>
</tr>
<tr>
<td></td>
<td>• A6</td>
</tr>
<tr>
<td></td>
<td>• Hagaki</td>
</tr>
<tr>
<td></td>
<td>• Wallet</td>
</tr>
<tr>
<td></td>
<td>• 3.5 x 5 in.</td>
</tr>
<tr>
<td>Quality</td>
<td>• *Automatic</td>
</tr>
<tr>
<td></td>
<td>• Draft</td>
</tr>
<tr>
<td></td>
<td>• Normal</td>
</tr>
<tr>
<td></td>
<td>• Photo</td>
</tr>
</tbody>
</table>

* Default factory setting

PictBridge Mode

Your printer automatically switches to PictBridge mode when you connect a PictBridge-enabled camera. You can print pictures using the controls of the camera.

<table>
<thead>
<tr>
<th>Main Menu</th>
<th>Mode Main Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>PictBridge</td>
<td>Paper Setup</td>
</tr>
</tbody>
</table>
1. When your printer changes to PictBridge mode, use the left and right **Arrow** buttons ⦅⦇ until the heading you want appears on the display, and then press the **Select** button ✈️.

2. Use the left and right **Arrow** buttons ⦅⦇ to scroll through the available menu items.

3. When the setting you want appears on the display, press the **Select** button ✈️ to save the setting.

### PictBridge menu item

<table>
<thead>
<tr>
<th>Paper Setup</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press the Select button ✈️ to access the Paper Setup Menu.</td>
<td></td>
</tr>
</tbody>
</table>

#### Photo Size
- *4 x 6 in.
- Wallet
- 3.5 x 5 in.
- 5 x 7 in.
- 8 x 10 in.
- 8.5 x 11 in.
- L
- 2L
- Hagaki
- A6
- A5
- B5
- A4
- 60 x 80 mm
- 9 x 13 cm
- 10 x 15 cm
- 13 x 18 cm
- 20 x 25 cm

#### Layout
- *Automatic
- Borderless
- 1 Per Page
- 2 Per Page
- 3 Per Page
- 4 Per Page
- 6 Per Page
- 8 Per Page
- 16 Per Page
- 1 Centered

#### Quality
- *Automatic
- Draft
- Normal
- Photo

*Default factory setting

---

**Office File Mode**

Office File mode is only available when a memory card or USB key containing documents is inserted into the printer or when the printer is connected to a configured internal network adapter.

The printer recognizes files that have the following file extensions:
To view or change the Office File Mode menu settings:

1. Ensure that the printer is connected to your computer, and is turned on.

2. Insert a memory card into the card slots or a USB key into the PictBridge port.

3. If the memory card or USB key contains documents only, the display automatically changes to OFFICE FILE. Use the left and right Arrow buttons to scroll through the files, and then press the Select button to print.

   If the memory card or USB key contains both documents and photos, the display asks which files to print. Use the left and right Arrow buttons to scroll to Documents, and then press the Select button.

4. Use the left and right Arrow buttons until the heading you want appears on the display, and then press the Select button.

<table>
<thead>
<tr>
<th>Office File menu item</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select File</td>
<td>Use the left and right Arrow buttons to scroll through the folders and files stored on your USB key or memory card. Press the Select button to access the contents of the folders or to choose the file that you want to print.</td>
</tr>
</tbody>
</table>

### Bluetooth Mode

Your printer automatically switches to Bluetooth mode when you insert a Bluetooth™ adapter (sold separately) into the PictBridge port.

<table>
<thead>
<tr>
<th>Main Menu</th>
<th>Mode Main Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bluetooth</td>
<td>Enable</td>
</tr>
<tr>
<td></td>
<td>Discovery</td>
</tr>
</tbody>
</table>
1. Use the left and right Arrow buttons ⬅️ ➡️ until the heading you want appears on the display, and then press the Select button 🔄.

2. Use the left and right Arrow buttons ⬅️ ➡️ to scroll through the available menu items.

3. When the setting you want appears on the display, press the Select button 🔄 to save the setting.

<table>
<thead>
<tr>
<th>Setup menu item</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>• Off</td>
</tr>
<tr>
<td></td>
<td>• *On</td>
</tr>
<tr>
<td>Discovery</td>
<td>• Off</td>
</tr>
<tr>
<td></td>
<td>• *On</td>
</tr>
<tr>
<td>Printer Name</td>
<td>The name of your printer appears on the display in this format: DellV305-service tag #. <strong>NOTE:</strong> The name appears on the printer list of devices that connect to your computer using the Bluetooth wireless specification.</td>
</tr>
<tr>
<td>Security Level</td>
<td>• High</td>
</tr>
<tr>
<td></td>
<td>• *Low</td>
</tr>
<tr>
<td><strong>NOTE:</strong> The Enter Passcode submenu is displayed if you choose High. Use the left and right Arrow buttons ⬅️ ➡️ to scroll through the numbers 0–9 for each digit of the passcode. Press the Select button 🔄 to select a number for each digit.</td>
<td></td>
</tr>
<tr>
<td>Pass Key</td>
<td>The current pass key value appears on the display. <strong>NOTE:</strong> The Pass Key only appears in the menu if Security Level is set to High.</td>
</tr>
</tbody>
</table>

*Default factory setting

---

**Setup Mode**

<table>
<thead>
<tr>
<th>Main Menu</th>
<th>Mode Main Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup</td>
<td>Paper Setup</td>
</tr>
<tr>
<td></td>
<td>Device Setup</td>
</tr>
<tr>
<td></td>
<td>Defaults</td>
</tr>
<tr>
<td></td>
<td>Network Setup</td>
</tr>
</tbody>
</table>

To access the Setup mode menu:

1. From the main menu, use the left and right Arrow buttons ⬅️ ➡️ to scroll to SETUP, and then press the Select button 🔄.

2. Use the left and right Arrow buttons ⬅️ ➡️ until the heading you want appears on the display, and then press the Select button 🔄.
3. Use the left and right Arrow buttons ‹ › to scroll to the available menu items, and then press the Select button  to save your settings.

<table>
<thead>
<tr>
<th>Scan menu item</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Setup</td>
<td>• Paper Size</td>
</tr>
<tr>
<td></td>
<td>• Paper Type</td>
</tr>
<tr>
<td>Device Setup</td>
<td>• Language</td>
</tr>
<tr>
<td></td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td>• Power Save</td>
</tr>
<tr>
<td></td>
<td>• Clear Settings Timeout</td>
</tr>
<tr>
<td>Defaults</td>
<td>• Photo Print Size</td>
</tr>
<tr>
<td></td>
<td>• Set Defaults</td>
</tr>
<tr>
<td>Network Setup</td>
<td>• Print Setup Page</td>
</tr>
<tr>
<td></td>
<td>• Wi-Fi Protected Setup</td>
</tr>
<tr>
<td></td>
<td>• Wireless Information</td>
</tr>
<tr>
<td></td>
<td>• TCP/IP Menu</td>
</tr>
<tr>
<td></td>
<td>• Reset Network Adapter Defaults</td>
</tr>
</tbody>
</table>

### Maintenance Mode

<table>
<thead>
<tr>
<th>Main Menu</th>
<th>Mode Main Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance</td>
<td>Ink Levels</td>
</tr>
<tr>
<td></td>
<td>Clean Cartridges</td>
</tr>
<tr>
<td></td>
<td>Align Cartridges</td>
</tr>
<tr>
<td></td>
<td>Print Test Page</td>
</tr>
</tbody>
</table>

To view or change the Maintenance Mode menu settings:

1. From the main menu, use the left and right Arrow buttons ‹ › to scroll to MAINTENANCE.

2. Press the Select button  .

3. Use the left and right Arrow buttons ‹ › until the heading you want appears on the display, and then press the Select button  .

<table>
<thead>
<tr>
<th>Maintenance menu item</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink Levels</td>
<td>Press the Select  button.</td>
</tr>
<tr>
<td>Clean Cartridges</td>
<td>Press the Select  button.</td>
</tr>
<tr>
<td>Align Cartridges</td>
<td>Press the Select  button.</td>
</tr>
<tr>
<td>Print Test Page</td>
<td>Press the Select  button.</td>
</tr>
</tbody>
</table>
You can share your printer with other users on the network through peer-to-peer sharing. Connect the printer directly to a computer (the host computer) using the USB cable, and enable it to be shared across the network through peer-to-peer sharing. Sharing the printer using your computer may slow down the speed of your computer.

To share the printer:
1. Assign a "share name" to the printer. For more information, see Sharing the Printer on the Network.
2. Set up the network computers that you want to connect and use the shared printer. For more information, see Adding the Shared Printer on Other Network Computers.

### Sharing the Printer on the Network

On the host computer or network computer where the printer is directly connected by USB cable, share the printer.

**In Windows Vista™:**
1. Click © Control Panel.
2. Click Hardware and Sound.
3. Click Printers.
4. Right-click your printer icon, and then select Sharing.
5. Click Change sharing options.
6. Click Continue.
7. Click Share this printer, and assign a name to your printer.
8. Click OK.

**In Windows® XP and Windows 2000:**
1. In Windows XP, click Start © Settings © Control Panel © Printers and Other Hardware © Printers and Faxes.
   In Windows 2000, click Start © Settings © Printers.
2. Right-click the printer icon, and then select Sharing.
3. Click Share this printer, and assign a name to your printer.
4. Click OK.

### Adding the Shared Printer on Other Network Computers

To share the printer with other computers on the network, perform the following steps on the client computers:

**In Windows Vista:**
1. Click ® Control Panel.

2. Click Hardware and Sound.

3. Click Printers.

4. Click Add a printer.

5. Click Add a network, wireless or Bluetooth printer.

6. To manually connect to the shared printer, click The printer I want isn’t listed.

7. From the Find a printer by name or TCP/IP address dialog box, click Select a shared printer by name, and then type the printer share name.

   To view the name of the computer that you want to share the printer with, go to the host computer.

   a. Click ® Control Panel.

   b. Click System and Maintenance.

   c. Click System.

8. Click Next.

9. Follow instructions on the computer screen to complete the installation.

In Windows XP and Windows 2000:

1. In Windows XP, click Start® Settings® Control Panel® Printers and Other Hardware® Printers and Faxes.

   In Windows 2000, click Start® Settings® Printers.

2. Click Add a printer.

3. From the Add Printer Wizard dialog box, click Next.

4. From the Local or Network Printer dialog box, click A network printer, or a printer attached to another computer.

5. Click Next.

6. From the Specify a Printer dialog box, click Connect to this printer, and enter the printer share name.

   To view the name of the computer that you want to share the printer with, go to the host computer.


   In Windows 2000, click Start® Settings® System.

   b. From the System Properties dialog box, click the Computer Name tab.

7. Click Next.

8. Follow the instructions on the computer screen to complete the installation.
Loading Paper and Originals

- Loading Paper into the Paper Support
- Understanding the Automatic Paper Type Sensor
- Loading Original Documents on the Scanner Glass

Loading Paper into the Paper Support

1. Fan the paper.

2. Center the paper on the paper support.

3. Adjust the paper guides so they rest against the edges of the paper.

NOTE: Do not pull on both paper guides simultaneously. When one paper guide is moved, the other adjusts accordingly.

NOTE: Do not force paper into the printer. The paper should be flat against the paper support surface, and the edges should be flush against both paper guides.

Print Media Guidelines

<table>
<thead>
<tr>
<th>Load up to:</th>
<th>Make sure:</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 sheets of plain paper</td>
<td>• The paper guides rest against the edges of the paper.</td>
</tr>
<tr>
<td></td>
<td>• You load letterhead paper with the print side facing up and the top of the</td>
</tr>
<tr>
<td></td>
<td>letterhead going into the printer first.</td>
</tr>
<tr>
<td>25 sheets of heavyweight</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Instructions</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| matte paper                 | The print side of the paper faces up.  
  - The paper guides rest against the edges of the paper.  
  - You select **Automatic**, **Normal**, or **Photo** print quality.                                                                                                           |
| 20 sheets of banner paper   |  
  - You remove all paper from the paper support before inserting banner paper.  
  - You use banner paper designed for inkjet printers.  
  - You place a stack of banner paper on or behind the printer, and feed in the first sheet.  
  - The paper guides rest against the edges of the paper.  
  - You select **A4 Banner** or **Letter Banner** paper size.                                                                                                                |
| 10 envelopes                |  
  - The print side of the envelope faces up.  
  - The paper guides rest against the edges of the envelope.  
  - You print the envelopes with **Landscape** orientation.  
  - **NOTE:** If you are mailing within Japan, the envelope can be printed in Portrait orientation with the stamp in the lower right corner or in Landscape orientation with the stamp in the lower left corner. If you are mailing internationally, print in Landscape orientation with the stamp in the upper left corner.  
  - You select the correct envelope size. Select the next biggest size if the exact envelope size is not listed, and set the left and right margins so your envelope is correctly positioned. |
| 25 sheets of labels         |  
  - The print side of the label sheet faces up.  
  - The paper guides rest against the edges of the label sheet.  
  - You select **Automatic**, **Normal**, or **Photo** print quality.                                                                                                           |
| 25 greeting cards, index cards, postcards, or photo cards |  
  - The print side of the cards faces up.  
  - The paper guides rest against the edges of the cards.  
  - You select **Automatic**, **Normal**, or **Photo** print quality.                                                                                                           |
| 25 sheets of photo/glossy paper |  
  - The print side of the paper faces up.  
  - The paper guides rest against the edges of the paper.                                                                                                                   |
Understanding the Automatic Paper Type Sensor

Your printer has an automatic paper type sensor that detects the following paper types:

- Plain/heavyweight matte
- Transparency
- Photo/glossy

If you load one of these paper types, the printer detects the paper type and automatically adjusts the Quality/Speed settings.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Quality/Speed settings</th>
<th>Black and Color Cartridges Installed</th>
<th>Photo and Color Cartridges Installed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain/heavyweight matte</td>
<td>Normal</td>
<td>Photo</td>
<td></td>
</tr>
<tr>
<td>Transparency</td>
<td>Normal</td>
<td>Photo</td>
<td></td>
</tr>
<tr>
<td>Photo/glossy</td>
<td>Photo</td>
<td>Photo</td>
<td></td>
</tr>
</tbody>
</table>

NOTE: Your printer cannot detect paper size.

To choose paper size:

1. With your document open, click **File** > **Print**.
   
The Print dialog box opens.

2. Click **Preferences, Properties, Options**, or **Setup** (depending on the program or operating system).
   
The Printing Preferences dialog box opens.

3. On the **Print Setup** tab, select the paper size.

4. Click **OK**.

The automatic paper type sensor is always on, unless you turn it off. To turn off the automatic paper type sensor for a specific print job:

1. With your document open, click **File** > **Print**.
   
The Print dialog box opens.

2. Click **Preferences, Properties, Options**, or **Setup** (depending on the program or operating system).
   
The Printing Preferences dialog box opens.
3. On the **Print Setup** tab, select the paper type.

4. Click **OK**.

To turn off the automatic paper type sensor for all print jobs:

1. *In Windows Vista™:*
   a. Click ® **Control Panel**.
   b. Click **Hardware and Sound**.
   c. Click **Printers**.

   *In Windows® XP, click Start® Control Panel® Printers and Other Hardware® Printers and Faxes.*

   *In Windows 2000, click Start® Settings® Printers.*

2. Right-click the printer icon.

3. Click **Printing Preferences**.

4. On the **Print Setup** tab, select the paper type.

5. Click **OK**.

---

### Loading Original Documents on the Scanner Glass

1. Open the top cover.

2. Place the document face down on the scanner glass.

   **NOTE:** Ensure that the upper left corner of the front of the item aligns with the arrow on the printer.
3. Close the top cover.
Replacing Ink Cartridges

1. Turn on your printer.

2. Lift the scanner base unit.

The ink cartridge carrier moves and stops at the loading position unless the printer is busy.

3. Press down on the ink cartridge lever to raise each ink cartridge lid.

4. Remove the old ink cartridges.

CAUTION: Before performing any of the procedures listed in this section, read and follow the safety information in your Owner's Manual.

Dell™ ink cartridges are available only through Dell. You can order more ink online at www.dell.com/supplies or by phone.

CAUTION: It is recommended that Dell ink cartridges be used for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.
5. Store the cartridges in an air-tight container, such as the storage unit you received with your photo cartridge, or dispose of them properly.

6. If you are installing new ink cartridges, remove the sticker and transparent tape from the back and bottom of each ink cartridge.

![Image of ink cartridges with sticker and tape removed]

**NOTICE:** Do not touch the gold contact area on the side or the metal nozzles on the bottom of the ink cartridges.

7. Insert the new ink cartridges. Make sure the black or photo ink cartridge is secure in the left ink cartridge carrier, and the color ink cartridge is secure in the right ink cartridge carrier.

**NOTE:** For normal printing, use a black cartridge and a color cartridge. For photo printing, replace the black cartridge with a photo cartridge.

![Image of ink cartridges properly inserted]

8. **Snap** each lid closed.

9. Lower the scanner base unit until it is completely closed.
Aligning Ink Cartridges

Your printer automatically prompts you to align the ink cartridges when they are installed or replaced. You may also need to align ink cartridges when characters are not properly formed or are not aligned at the left margin, or when vertical or straight lines appear wavy.

To align the ink cartridges from the operator panel:

1. Load plain paper. For more information, see Loading Paper into the Paper Support.
2. Use the left and right Arrow buttons to scroll to MAINTENANCE, and then press the Select button.
3. Use the left and right Arrow buttons to scroll to Align Cartridges, and then press the Select button.

An alignment page prints. The ink cartridges align when the page prints. You may discard the alignment page when the alignment is complete.

To align the ink cartridges from the printer software:

1. Load plain paper.
2. In Windows Vista™:
   a. Click Control Panel.
   b. Click Hardware and Sound.
   c. Click Printers.

   In Windows® XP, click Start® Control Panel® Printers and Other Hardware® Printers and Faxes.
   In Windows 2000, click Start® Settings® Printers.
3. Right-click the Dell V305 icon.
4. Click Printing Preferences.

   The Printing Preferences dialog box opens.
5. Click the Maintenance tab.
6. Click Align Ink Cartridges.
7. Click Print.

   An alignment page prints. The ink cartridges align when the page prints. You may discard the alignment page when the alignment is complete.
Cleaning the Ink Cartridge Nozzles

You may need to clean the nozzles when:

- White lines appear in graphics or solid black areas.
- Print appears smudged or too dark.
- Colors fade, do not print, or do not print correctly.
- Vertical lines appear jagged, or edges appear rough.

To clean the nozzles from the operator panel:

1. Load plain paper. For more information, see *Loading Paper into the Paper Support*.
2. Use the left and right *Arrow* buttons ←→ to scroll to *MAINTENANCE*, and then press the *Select* button ☑.
3. Use the left and right *Arrow* buttons ←→ to scroll to *Clean Cartridges*, and then press the *Select* button ☑.

To clean the nozzles from the printer software:

1. Load plain paper.
2. *In Windows Vista:*
   a. Click ® *Control Panel*.
   b. Click *Hardware and Sound*.
   c. Click *Printers*.

   *In Windows XP*, click *Start® Control Panel® Printers and Other Hardware® Printers and Faxes*.

   *In Windows 2000*, click *Start® Settings® Printers*.
3. Right-click the *Dell V305* icon.
4. Click *Printing Preferences*.
   The *Printing Preferences* dialog box opens.
5. Click the *Maintenance* tab.
6. Click *Clean Ink Cartridges*.
   The cleaning page prints.
7. If the print quality has not improved, click *Clean Again*.
8. Print your document again to verify the improved print quality.

If you are still not satisfied with the print quality, wipe the nozzles with a clean, dry cloth, and then print your document again.

Cleaning the Exterior of the Printer

1. Make sure that the printer is turned off and unplugged from the wall outlet.

⚠️ **CAUTION:** To avoid the risk of electric shock, unplug the power cord from the wall outlet and disconnect all cables to the printer before proceeding.
2. Remove paper from the paper support and paper exit tray.

3. Dampen a clean, lint-free cloth with water.

**NOTICE:** Do not use household cleaners or detergents, as they may damage the finish of the printer.

4. Wipe only the outside of the printer, making sure to remove any ink residue that has accumulated on the paper exit tray.

**NOTICE:** Using a damp cloth to clean the interior may cause damage to your printer. Damage to the printer caused by not following the correct instructions for cleaning will not be covered under warranty.

5. Make sure the paper support and paper exit tray are dry before beginning a new print job.

---

### Changing the Default Operator Panel Settings

To change the default settings on the operator panel:

1. Turn on the printer.

2. Change the operator panel settings.

3. Use the left and right **Arrow** buttons ➙ to scroll to **SETUP**, and then press the **Select** button ☑.

4. Use the left and right **Arrow** buttons ➙ to scroll to **Defaults**, and then press the **Select** button ☑.

5. Use the left and right **Arrow** buttons ➙ to scroll to **Set Defaults**, and then press the **Select** button ☑.

6. Use the left and right **Arrow** buttons ➙ to scroll to **Use Current**, and then press the **Select** button ☑.

   The current settings on the operator panel are saved as the new default settings.

---

### Restoring Factory Default Settings

1. Turn on the printer.

2. From the operator panel, use the left and right **Arrow** buttons ➙ to scroll to **SETUP**, and then press the **Select** button ☑.

3. Use the left and right **Arrow** buttons ➙ to scroll to **Defaults**, and then press the **Select** button ☑.

4. Use the left and right **Arrow** buttons ➙ to scroll to **Set Defaults**, and then press the **Select** button ☑.

5. Use the left and right **Arrow** buttons ➙ to scroll to **Use Factory**, and then press the **Select** button ☑.

6. Select the correct language and country.
Printing Documents

1. Turn on your computer and printer, and make sure they are connected.
2. Load the paper. For more information, see Loading Paper into the Paper Support.
3. With your document open, click File ➤ Print.
   The Print dialog box opens.
4. Click Preferences, Properties, Options, or Setup (depending on the program or operating system).
   The Printing Preferences dialog box opens.
5. On the Print Setup and Advanced tabs, make any necessary changes for your document.
6. After customizing your settings, click OK.
   The Printing Preferences dialog box closes.
7. Click OK or Print.

Printing Photos

1. Turn on your computer and printer, and make sure they are connected.
2. Load paper with the print side facing up.
3. With your document open, click File ➤ Print.

**NOTE:** Dell recommends you use a color cartridge and a photo cartridge for printing photos.

**NOTE:** Photo/glossy paper is recommended for printing photos.
The Print dialog box opens.

4. Click Preferences, Properties, Options, or Setup (depending on the program or operating system).

The Printing Preferences dialog box opens.

5. On the Print Setup tab, select Photo, and then select the dpi settings for the photo from the drop-down menu.

   **NOTE:** To print borderless photos, click the Borderless check box on the Print Setup tab, and then select the borderless paper size from the drop-down menu on the Advanced tab. Borderless printing is only performed if you are using photo/glossy paper. The printout on non-photo paper contains a 2 mm margin on all sides.

6. On the Print Setup and Advanced tabs, make any necessary changes for your document.

7. When you finish customizing your settings, click OK.

   The Printing Preferences dialog box closes.

8. Click OK or Print.

9. Remove each photo after it exits the printer to prevent your photos from sticking together or smudging.

   **NOTE:** Before placing your prints in a nonadhesive photo album or frame, allow sufficient time for the prints to dry thoroughly (12 to 24 hours, depending on ambient conditions). This maximizes the life of your prints.

**Printing Photos From a PictBridge-Enabled Camera**

Your printer supports printing from a PictBridge-enabled camera.

1. Turn on your printer.

2. Insert one end of the USB cable into the camera.

3. Insert the other end of the USB cable into the PictBridge port on the front of the printer.

   See the instructions included with your camera for selection of the appropriate camera USB settings and PictBridge connection and usage information.

   **NOTE:** When your printer is not connected to a computer, and a PictBridge camera is connected to your printer, some of the functions of your printer operator panel buttons may be unavailable. These functions become available after you disconnect the PictBridge camera from your printer.

4. Turn on your digital camera.

   The printer automatically enters PictBridge mode.

5. See the instructions included with your camera to begin printing photos.

   **NOTICE:** Do not remove the PictBridge-enabled device or touch the printer near the area of the memory card or PictBridge-enabled device while actively printing from PictBridge. Data corruption can occur.
NOTE: If your digital camera has computer and printer (PTP) USB mode selections, use the printer (PTP) USB mode selection for PictBridge printing. For more information, see the documentation included with your camera.

**Printing Photos From the Computer**

1. Turn on your computer and printer, and ensure that they are connected.

2. Load the paper. For more information, see [Loading Paper into the Paper Support](#).

3. **In Windows Vista™:**
   a. Click ® Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   **In Windows® XP and Windows 2000:**
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

4. Select Dell Imaging Toolbox.
   The Dell Imaging Toolbox dialog box opens.

5. From the Home screen, click My Photo Album.

6. From the Folders pane, open the folder that contains your photos.

7. Click to select the photo or photos you want to print.

8. Click Photo Prints.

9. From the drop-down lists, select the print quality, paper size, and paper type settings you want.

10. To select multiple prints of a photo, or to select photo sizes other than 10 x 15 cm (4 x 6 in.), select the options you want in the table. Use the drop-down list in the last column to view and select other sizes.

11. Click Print Now.

**Printing Borderless Photos**

1. Turn on your computer and printer, and ensure that they are connected.

2. Load the paper. For more information, see [Loading Paper into the Paper Support](#).

3. **In Windows Vista:**
   a. Click ® Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   **In Windows XP and Windows 2000:**
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

4. Select Dell Imaging Toolbox.
The Dell Imaging Toolbox dialog box opens.

5. From the Home screen, click Print Borderless Photos.

6. From the Folders pane, open the folder that contains your photos.

7. Click to select the photo or photos you want to print.

8. Click Next.

9. From the drop-down lists, select the print quality, paper size, and paper type settings you want.

10. From the last column of the table, select the number of prints you want.

11. Click Print Now.

Creating Photo Greeting Cards

1. Turn on your computer and printer, and ensure that they are connected.

2. Load the paper. For more information, see Loading Paper into the Paper Support.

3. In Windows Vista:
   a. Click Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   In Windows XP and Windows 2000:
   Click Start Programs or All Programs Dell Printers Dell V305.

4. Select Dell Imaging Toolbox.

    The Dell Imaging Toolbox dialog box opens.

5. From the Home screen, click Activities.

6. Click Make Photo Greeting Cards.

7. From the Style tab, click to select a style for your greeting card.

8. From the Photo tab, open the folder that contains your photos.

9. Select and drag a photo into the preview pane on the right side of the screen.

10. Click the text area to add text to your photo greeting card.

11. After editing your text, click OK.

12. If you want to create another photo greeting card using a different style and/or photo, click Add New Card, and repeat step 7 through step 11.

13. If you want to print your photo greeting card, select Print your Photo Greeting Card from the Share tab.

14. Select the copy quality, paper size, paper type, and the number of copies to print.

15. Click Print Now.
16. If you want to e-mail your photo greeting card:
   a. Click **E-mail your Photo Greeting Card** from the Share tab.
   b. From the **Send Quality and Speed** area of the screen, select the image size.
   c. Click **Create E-mail** to create an e-mail message with your photo greeting card attached.

---

**Printing From a Bluetooth®-Enabled Device**

- This printer is compliant with Bluetooth Specification 2.0. It supports the following profiles: Object Push Profile (OPP), Serial Port Profile (SPP), Basic Print Profile (BPP), and PCL3 printing. Check with your Bluetooth-enabled device manufacturers (cellular phone or PDA) to determine their hardware compatibility and interoperability. It is recommended that you use the latest firmware on your Bluetooth-enabled device.

- To print Microsoft documents from your Windows® Mobile/Pocket PC PDA, additional third-party software and drivers are required. For more information about the required software, see the documentation for your PDA.

- Before you call Dell customer support, see the section for information on setting up a connection with a Bluetooth-enabled device. You can also visit the Dell Support website at support.dell.com. This website contains the latest documentation. Ensure that you read the documentation that came with your Bluetooth device for setup instructions.

**Setting up a Connection Between Your Printer and a Bluetooth-Enabled Device**

⚠️ **NOTE**: The printer does not support printing files from your computer using a Bluetooth connection.

You need to set up a connection between a Bluetooth-enabled device and your printer if you are sending a print job from the Bluetooth device for the first time. You will need to repeat the setup if:

- You reset the printer to its factory default settings. For more information, see **Restoring Factory Default Settings**.

- You changed the Bluetooth security level or the Bluetooth pass key. For more information, see **Setting the Bluetooth Security Level**.

- The Bluetooth-enabled device you are using requires users to set up a Bluetooth connection on every print job. Refer to the instructions included with the device for Bluetooth printing information.

- You cleared the contents of the Bluetooth device list. For more information, see **Bluetooth Mode**.

- The name of the Bluetooth device you are using is automatically deleted from the Bluetooth device list.

When the Bluetooth security level is set to High, the printer saves a list of up to 8 Bluetooth devices that have previously set up a connection with the printer. If there are already 8 devices on the list, and then you need to set up a connection for another Bluetooth device, the first device is automatically deleted from the list so that the new device can be stored. You need to repeat the setup of the deleted device to be able to send a print job to the printer.

⚠️ **NOTE**: You need to set up a connection for each Bluetooth device that you will use to send a print job to the printer.

To set up a connection between the printer and a Bluetooth-enabled device:

1. Turn on the printer.

2. Insert a USB Bluetooth adapter into the USB port located on the front of the printer.
**NOTE:** A Bluetooth adapter is not included with the printer.

3. Use the left and right **Arrow** buttons ⬤ to scroll to **BLUETOOTH**, and then press the **Select** button ⬤.

4. Use the left and right **Arrow** buttons ⬤ to scroll to **Discovery**, and then press the **Select** button ⬤.

5. Use the left and right **Arrow** buttons ⬤ to scroll to **On**, and then press the **Select** button ⬤.

   The printer is now ready to accept a connection from a Bluetooth-enabled device.

6. Configure the Bluetooth-enabled device to set up a connection to the printer. Refer to the instructions included with the device for Bluetooth connection information.

   **NOTE:** If the Bluetooth Security Level on the printer is set to High, you must enter a pass key. For more information, see [Setting the Bluetooth Security Level](#).

---

### Setting the Bluetooth Security Level

1. Turn on the printer.

2. Insert a Bluetooth USB adapter into the USB port.

   **NOTE:** A Bluetooth adapter is not included with the printer.

3. Use the left and right **Arrow** buttons ⬤ to scroll to **BLUETOOTH**, and then press the **Select** button ⬤.

4. Use the left and right **Arrow** buttons ⬤ to scroll to **Security Level**, and then press the **Select** button ⬤.

5. Use the left and right **Arrow** buttons ⬤ to choose a security level, and then press the **Select** button ⬤.

   - Choose **Low** to allow Bluetooth devices to connect and send print jobs to your printer without requiring users to enter a pass key.
   
   - Choose **High** to require users to enter a four-digit numeric pass key on the Bluetooth device before connecting and sending print jobs to the printer.
6. The Pass Key menu opens on the operator panel display if you set the security level to High. Use the keypad to enter your four-digit pass key, and then press the Select button.

7. Use the left and right Arrow buttons to scroll to Yes when prompted to save the new pass key, and then press the Select button.

**Printing From a Bluetooth-Enabled Device**

1. Turn on the printer.

2. Insert a USB Bluetooth adapter into the USB port.

   ![Bluetooth Adapter](image)

   **NOTE:** A Bluetooth adapter is not included with the printer.

3. Make sure the Bluetooth mode is turned on. For more information, see Bluetooth Mode.

4. Make sure the printer is set up to receive Bluetooth connections. For more information, see Setting up a Connection Between Your Printer and a Bluetooth-Enabled Device.

5. Set up the Bluetooth device to print to the printer. Refer to the instructions included with the device for Bluetooth printing setup information.

6. See the instructions included with the Bluetooth device to begin printing.

   **NOTE:** If the Bluetooth Security Level on the printer is set to High, you must enter a pass key. For more information, see Setting the Bluetooth Security Level.

**Printing Envelopes**

1. Turn on your computer and printer, and ensure that they are connected.

2. Load the envelope with the print side facing up.

3. With your document open, click File > Print.
The Print dialog box opens.

4. Click Preferences, Properties, Options, or Setup (depending on the program or operating system).

The Printing Preferences dialog box opens.

5. On the Print Setup tab, select Envelope, and then choose the size of the envelope from the Paper size: dropdown menu.

   **NOTE:** If you are mailing within Japan, the envelope can be printed in portrait orientation with the stamp in the lower right corner or in landscape orientation with the stamp in the lower left corner. If you are mailing internationally, print landscape orientation with the stamp in the upper left corner.

If mailing within Japan, the envelopes can be loaded in two ways:

![Loading envelopes in Japan](image1)

If mailing internationally, load the envelope this way:

![Loading envelopes internationally](image2)

6. On the Print Setup and Advanced tabs, make any necessary changes for your document.

7. When you finish customizing your settings, click OK.

   The Printing Preferences dialog box closes.

8. Click OK or Print.

---

**Printing More Than One Page on a Sheet of Paper**

1. Turn on your computer and printer, and ensure that they are connected.

2. Load the paper. For more information, see Loading Paper into the Paper Support.

3. With your document open, click File® Print.

4. Click Preferences, Properties, Options, or Setup (depending on the program or operating system).
The **Printing Preferences** dialog box opens.

5. On the **Advanced** tab, select **N-up** from the **Layout** drop-down list.

6. From the **Pages per sheet** drop-down list, select how many pages you want to be printed on one sheet.

7. Select the **Print Page Borders** check box if you want borders between pages.

8. On the **Print Setup** tab, make any additional changes for your document.

9. After customizing your settings, click **OK**.

   The **Printing Preferences** dialog box closes.

10. Click **OK** or **Print**.

---

**Printing an Image as a Multi-Page Poster**

1. Turn on your computer and printer, and make sure they are connected.

2. Load the paper. For more information, see **Loading Paper into the Paper Support**.

3. With your document open, click **File** ➤ **Print**.

4. Click **Preferences**, **Properties**, **Options**, or **Setup** (depending on the program or operating system).

   The **Printing Preferences** dialog box opens.

5. On the **Advanced** tab, select **Poster** from the **Layout** drop-down list.

6. Select the size of the poster.

7. On the **Print Setup** tab and **Advanced** tab, make any additional changes for your document.

8. After customizing your settings, click **OK**.

   The **Printing Preferences** dialog box closes.

9. Click **OK** or **Print**.

---

**Printing a Banner**

1. Turn on your computer and printer, and make sure they are connected.

2. Load the paper. For more information, see **Loading Paper into the Paper Support**.

3. With your document open, click **File** ➤ **Print**.

4. Click **Preferences**, **Properties**, **Options**, or **Setup** (depending on the program or operating system).

   The **Printing Preferences** dialog box opens.

5. On the **Advanced** tab, select **Banner** from the **Layout** drop-down list, and then select **Letter Banner** or **A4 Banner** from the **Banner Paper Size** drop-down list.

6. On the **Print Setup** and **Advanced** tabs, make any additional changes for your document.

7. After customizing your settings, click **OK**.
The Printing Preferences dialog box closes.

8. Click OK or Print.

NOTE: Once the printer begins printing, wait until you can see the leading edge of the banner exiting the printer, and then carefully unfold the paper down to the floor in front of the printer.

---

**Printing Collated Copies of Your Document**

1. Turn on your computer and printer, and make sure they are connected.

2. Load the paper. For more information, see Loading Paper into the Paper Support.

3. With your document open, click File ➤ Print.

   The Print dialog box opens.

4. Click Preferences, Properties, Options, or Setup (depending on the program or operating system).

   The Printing Preferences dialog box opens.

5. On the Print Setup tab, specify the number of copies to print.

   NOTE: You must specify more than one copy for the Collate copies check box to become active.

6. Select the Collate copies check box.

7. On the Print Setup and Advanced tabs, make any additional changes for your document.

8. After customizing your settings, click OK.

   The Printing Preferences dialog box closes.

9. Click OK or Print.

---

**Printing a Booklet**

Before you change any Printing Preferences settings, you must select the correct paper size from the program. You can print booklets using these paper sizes:

- Letter
- A4

1. Load the paper. For more information, see Loading Paper into the Paper Support.

2. With your document open, click File ➤ Print.

3. From the Print dialog box, click Properties, Preferences, Options, or Setup (depending on the program or operating system).

4. Click the Advanced tab.

5. From the Layout drop-down menu, select Booklet.

6. If you are printing a large booklet, select the number of Sheets per bundle.

   NOTE: A bundle is a set number of sheets of paper folded together. The printed bundles are stacked, one on top of the other, keeping the correct page order. The stacked bundles can be bound to make a booklet. When
printing with a heavier paper stock, select a smaller number of Sheets per bundle.

7. Click OK to close any printer software dialog boxes that are open.

8. Print the document.

NOTE: For help binding and assembling the booklet, see Assembling a Booklet.

Assembling a Booklet

1. Flip the printed stack of papers over in the paper exit tray.

2. Take the first bundle from the stack, fold it in half, and then set it aside with the front page down.

3. Take the next bundle from the stack, fold it in half, and then stack it with the front page down on top of the first bundle.

4. Stack the rest of the bundles with the front page down, one on top of the other, until the booklet is complete.

5. Bind the bundles together to complete the booklet.

Duplexing a Print Job (Two-Sided Printing)

Manual duplex allows you to print your document on both sides of the paper. The printer prints the odd-numbered pages of the document on the front sides of the paper. Reload the document with the blank side of the paper facing up, and print the even-numbered pages of the document on the back sides of the paper.

1. Turn on your computer and printer, and ensure that they are connected.

2. Load the paper. For more information, see Loading Paper into the Paper Support.

3. With your document open, click File® Print.

4. Click Preferences, Properties, Options, or Setup (depending on the program or operating system).

5. Click the Advanced tab, and then select the 2-sided printing check box.

6. Select how you want to bind your pages.

7. After customizing your settings, click OK.

   The Printing Preferences dialog box closes.

8. Click OK or Print.
9. When all the odd-numbered pages have exited the printer, follow the instructions on your computer screen.

## Canceling a Print Job

### Sent From a Local Computer

There are two ways to cancel a print job sent from a computer that is connected to the printer by a USB cable.

#### From the Printers folder:

1. **In Windows Vista:**
   a. Click `Control Panel`
   b. Click `Hardware and Sound`
   c. Click `Printers`

   *In Windows® XP*, click `Start ® Settings ® Control Panel ® Printers and Other Hardware ® Printers and Faxes`.

   *In Windows 2000*, click `Start ® Settings ® Printers`.

2. Right-click the Dell V305 icon.

3. Click `Open`.

4. Select the job you want to cancel from the list that appears.

5. From the Document menu, click `Cancel`.

#### From the Printing Status window:

The Printing Status window automatically opens at the bottom-right part of your screen when you send a print job. Click **Cancel Printing** to cancel the current print job.

#### From the Taskbar:

1. Double-click the printer icon at the bottom-right portion of your computer screen or the Taskbar.

2. Double-click the print job that you want to cancel.

3. Click `Cancel`.

### Sent From a Bluetooth-Enabled Device

#### From the printer:

- Press the **Cancel** button to cancel the print job and terminate the Bluetooth connection.

- Press the **Power** button to cancel the print job, terminate the Bluetooth connection, and turn the printer off.

#### From the Bluetooth-enabled device:

See the documentation that came with your device for information.
Sent From a Computer Over a Wireless Network

1. **In Windows Vista**:
   a. Click ® Control Panel.
   b. Click Hardware and Sound.
   c. Click Printers.

   *In Windows XP*, click Start ® Settings ® Control Panel ® Printers and Other Hardware ® Printers and Faxes.

   *In Windows 2000*, click Start ® Settings ® Printers.

2. Right-click the **Dell V305** icon.

3. Click **Open**.

4. Select the job you want to cancel from the list that appears.

5. From the **Document** menu, click **Cancel**.

---

**Changing Printing Preferences Defaults**

When you send a document or photo to print, you can specify various settings such as print on both sides of the paper, print in higher or lower quality, print only in black and white, and more. If you have preferred settings, you can make these the default so you do not have to specify your printing preferences each time you send a print job.

To make your preferred settings the default print settings for most programs, open the Printing Preferences dialog box from the Printers folder.

1. **In Windows Vista**:
   a. Click ® Control Panel.
   b. Click Hardware and Sound.
   c. Click Printers.

   *In Windows XP*, click Start ® Settings ® Control Panel ® Printers and Other Hardware ® Printers and Faxes.

   *In Windows 2000*, click Start ® Settings ® Printers.

2. Right-click the **Dell V305** icon.

3. Select **Printing Preferences**.

4. Change the settings that you want to set as default when printing from most programs.

**From the Print Setup tab, you can:**

- Change the default print quality to **Draft**, **Normal**, or **Photo**.
- Change the default media type and paper size.
- Make black and white printing and borderless printing the default setting.
- Change the default orientation.
- Change the default number of copies.

**From the Advanced tab, you can:**
Specify layouts that you want to set as default.

**From the Maintenance tab:**
There are no print settings to set as default from the Maintenance tab. From here, you can:

- Install, clean, and align ink cartridges.
- Print a test page.
- Get information on sharing your printer on a network.
Troubleshooting

- Setup Problems
- Copying Problems
- Error Messages
- Scanning Problems
- Clearing Paper Jams
- Networking Problems
- Avoiding Jams and Misfeeds
- Memory Card Problems
- Paper Problems
- Improving Print Quality
- Printing Problems
- General Guidelines for Selecting or Loading Print Media

If the printer does not work, ensure that the printer is properly connected to the electrical outlet and computer, if using a computer.

For more help and to check the latest information on troubleshooting your printer, please visit http://support.dell.com/support.

Setup Problems

Computer Problems

Verify that your printer is compatible with your computer.

The printer supports Windows Vista™, Windows® XP, and Windows 2000 only.

Windows ME, Windows 98, and Windows 95 are not supported by this printer.

Ensure that you have turned on both your printer and your computer.

Check the USB cable.

- Ensure that the USB cable is firmly connected to your printer and your computer.
- Shut down the computer, reconnect the USB cable as shown on the Setting Up Your Printer poster, and then restart the computer.

If the software installation screen does not appear automatically, install the software manually.

1. Insert the Drivers and Utilities CD.
2. In Windows Vista®, click Computer.  
   In Windows XP, click Start® My Computer.  
   In Windows 2000, double-click My Computer from your desktop.
3. Double-click the CD-ROM drive icon, and then double-click setup.exe.
4. When the printer software installation screen appears, click Using a USB cable or Using a wireless network.
5. Follow the instructions on your screen to complete the installation.
Determine if the printer software is installed.

In Windows Vista:

1. Click Programs.
2. Click Dell Printers.

In Windows XP and Windows 2000:

Click Start Programs or All Programs Dell Printers Dell V305.

If the printer does not appear in the list of printers, the printer software is not installed. Install the printer software. For more information, see Removing and Reinstalling Software.

Correct communication problems between the printer and the computer.

- Remove the USB cable from your printer and your computer. Reconnect the USB cable to your printer and your computer.
- Turn off the printer. Unplug the printer power cable from the electrical outlet. Reconnect the printer power cable into the electrical outlet, and turn on the printer.
- Restart your computer.
- If the problem still exists, replace the USB cable.

Set your printer as the default printer.

1. In Windows Vista:
   a. Click Control Panel.
   b. Click Hardware and Sound.
   c. Click Printers.

   In Windows XP, click Start Control Panel Printers and Other Hardware Printers and Faxes.
   In Windows 2000, click Start Settings Printers.

2. Right-click the Dell V305 icon.
3. Select Set as Default Printer.

Printer won’t print and print jobs are stuck in the print queue.

Check for multiple instances of the printer installed on your computer.

1. In Windows Vista:
   a. Click Control Panel.
   b. Click Hardware and Sound.
   c. Click Printers.

   In Windows XP, click Start Control Panel Printers and Other Hardware Printers and Faxes.
   In Windows 2000, click Start Settings Printers.
2. Check for multiple objects for your printer.

3. Print a job to each of these print objects to see which printer is active.

4. Set that print object as the default printer:
   a. Right-click the **Dell V305** icon.
   b. Click **Set as Default Printer**.

5. Delete the other copies of the print object by right-clicking the printer name and selecting **Delete**.

To prevent multiple instances of the printer in your **Printers** folder, ensure you always plug the USB cable back into the same USB port that was originally used for the printer. Also, do not install printer drivers multiple times from the **Drivers and Utilities** CD.

---

**Printer Problems**

- **Ensure the printer power cable is firmly connected to the printer and the electrical outlet.**

- **Determine if the printer has been held or paused.**
  1. In **Windows Vista**:
     a. Click **Control Panel**.
     b. Click **Hardware and Sound**.
     c. Click **Printers**.

   In **Windows XP**, click **Start** ® **Control Panel** ® **Printers and Other Hardware** ® **Printers and Faxes**.

   In **Windows 2000**, click **Start** ® **Settings** ® **Printers**.

   2. Right-click the **Dell V305** icon.

   3. Make sure **Pause Printing** is not selected. If **Pause Printing** is selected, click it to clear the option.

- **Check for blinking lights on the printer.**
  For more information, see **Error Messages**.

- **Ensure you installed the ink cartridges correctly and removed the sticker and tape from each cartridge.**

- **Make sure you loaded the paper correctly.**
  For more information, see **Loading Paper into the Paper Support**.

- **Make sure the printer is not connected to a PictBridge-enabled camera.**
  For more information, see **Printing Photos From a PictBridge-Enabled Camera**.

---

**Error Messages**

For more help and to check the latest information on troubleshooting your printer, please visit [http://support.dell.com/support](http://support.dell.com/support).
<table>
<thead>
<tr>
<th>Error Message:</th>
<th>What it indicates:</th>
<th>Solution:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Not Connected</td>
<td>Attempting to scan or print Office files from a memory card or USB key, or selecting the <strong>Save to Computer</strong> option when the printer is not connected to a computer or the computer is not turned on.</td>
<td>Ensure that your printer is connected to your computer.</td>
</tr>
<tr>
<td>This function is not supported using this network connection.</td>
<td>Attempting to print Office files from a memory card or USB key when the printer is connected to a network adapter, and not directly attached to the computer.</td>
<td>Connect the printer directly to a computer.</td>
</tr>
<tr>
<td>No response</td>
<td>A timeout has occurred after the user pressed the <strong>Start</strong> button.</td>
<td>Press the <strong>Cancel</strong> button.</td>
</tr>
<tr>
<td>Load Paper then press ⚫</td>
<td>The printer is out of paper.</td>
<td>Load paper into the printer, and then press the <strong>Select</strong> button to continue printing. For more information, see <a href="#">Loading Paper into the Paper Support</a>.</td>
</tr>
<tr>
<td>Clear Carrier Jam then press ⚫</td>
<td>A printhead carrier jam occurred.</td>
<td>Remove obstructions from the carrier path or close the cartridge carrier lids, and then press the <strong>Select</strong> button.</td>
</tr>
<tr>
<td>Clear paper jam then press ⚫</td>
<td>A paper jam exists in the printer.</td>
<td>Clear the paper jam. For more information, see <a href="#">Check for a paper jam</a>.</td>
</tr>
<tr>
<td>Cover Open.</td>
<td>The scanner base unit is open.</td>
<td>Close the scanner base unit.</td>
</tr>
<tr>
<td>Paper Size</td>
<td>The paper in the printer is smaller than the selected Blank Paper Size.</td>
<td>Change the Blank Paper Size to match the paper in the printer, or press the <strong>Select</strong> button to continue printing.</td>
</tr>
<tr>
<td>Photo size is larger than paper size. Press ⚫ to pick a new paper size.</td>
<td>The paper in the printer is smaller than the selected Blank Paper Size.</td>
<td>Change the Blank Paper Size to match the paper in the printer, or press the <strong>Select</strong> button to continue printing.</td>
</tr>
<tr>
<td>Unsupported Paper Size</td>
<td>A photo print job is initiated, and an unsupported paper size is selected.</td>
<td>Press the <strong>Back</strong> button to cancel the job, and choose a new paper size.</td>
</tr>
<tr>
<td>• Install a black or photo print cartridge on the left side.</td>
<td>An ink cartridge is missing.</td>
<td>Insert a black or photo cartridge in the left cartridge carrier and a color cartridge in the right carrier. For more information, see <a href="#">Replacing Ink Cartridges</a>.</td>
</tr>
<tr>
<td>• Install a color print cartridge on the right side.</td>
<td>A ? symbol is shown for every missing cartridge with the message appearing below it.</td>
<td>Insert a black or photo cartridge in the left cartridge carrier and a color cartridge in the right carrier. For more information, see <a href="#">Replacing Ink Cartridges</a>.</td>
</tr>
<tr>
<td>• Install both cartridges.</td>
<td>An ink cartridge is missing.</td>
<td>Insert a black or photo cartridge in the left cartridge carrier and a color cartridge in the right carrier. For more information, see <a href="#">Replacing Ink Cartridges</a>.</td>
</tr>
<tr>
<td>• Black Ink Low. Order Ink @ <a href="http://WWW.DELL.COM/SUPPLIES">WWW.DELL.COM/SUPPLIES</a>. Press ⚫ to continue.</td>
<td>The ink cartridge is running low on ink.</td>
<td>Replace the ink cartridge. For more information, see <a href="#">Replacing Ink Cartridges</a>.</td>
</tr>
<tr>
<td>• Color Ink Low. Order Ink @ <a href="http://WWW.DELL.COM/SUPPLIES">WWW.DELL.COM/SUPPLIES</a>. Press ⚫ to continue.</td>
<td>The ink cartridge is running low on ink.</td>
<td>Replace the ink cartridge. For more information, see <a href="#">Replacing Ink Cartridges</a>.</td>
</tr>
<tr>
<td>• Photo Ink Low. Order Ink @ <a href="http://WWW.DELL.COM/SUPPLIES">WWW.DELL.COM/SUPPLIES</a>. Press ⚫ to continue.</td>
<td>The ink cartridge is running low on ink.</td>
<td>Replace the ink cartridge. For more information, see <a href="#">Replacing Ink Cartridges</a>.</td>
</tr>
<tr>
<td>• Black and Color Ink Low. Order Ink @ <a href="http://WWW.DELL.COM/SUPPLIES">WWW.DELL.COM/SUPPLIES</a>. Press ⚫ to continue.</td>
<td>An ink cartridge is invalid.</td>
<td>Replace the invalid ink cartridge. For more information, see <a href="#">Replacing Ink Cartridges</a>.</td>
</tr>
<tr>
<td>• Photo and Color Ink Low. Order Ink @ <a href="http://WWW.DELL.COM/SUPPLIES">WWW.DELL.COM/SUPPLIES</a>. Press ⚫ to continue.</td>
<td>An ink cartridge is invalid.</td>
<td>Replace the invalid ink cartridge. For more information, see <a href="#">Replacing Ink Cartridges</a>.</td>
</tr>
<tr>
<td>• Left cartridge error. Replace</td>
<td>An ink cartridge is invalid.</td>
<td>Replace the invalid ink cartridge. For more information, see <a href="#">Replacing Ink Cartridges</a>.</td>
</tr>
<tr>
<td>Problem Description</td>
<td>Solution</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>Clearing Paper Jams</td>
<td>Paper jam in the paper path</td>
<td></td>
</tr>
</tbody>
</table>

Alignment Problem. Remove tape from cartridges or check troubleshooting. Press to retry.

- Cartridge. Right cartridge error. Replace Cartridge.
- Install both cartridges.

The tape was not removed from the ink cartridges before the cartridges were installed.

Remove the tape from the ink cartridges. For more information, see Replacing Ink Cartridges.


One or both of the ink cartridges is invalid.

Remove both cartridges, then install one at a time to determine which is invalid.

Memory card problem. Ensure that it is not damaged and is inserted correctly.

A memory card or USB key is not inserted correctly, is damaged, not functional, or its format is not supported.

Remove the memory card or the USB key. Refer to the documentation that came with your device for more information.

Invalid Device. The attached USB device is not supported. Please disconnect and refer to user manual.

The attached device is not supported, or the PictBridge-enabled digital camera is not set to the correct USB mode.

Disconnect the device, or check the USB mode setup. Refer to the documentation that came with your digital camera for more information.

Only one device or media card is allowed. Please remove all but one device or card.

More than one memory card or device is inserted in the printer.

Remove all memory cards and devices.

Unplug the camera to use other printer features.

A non-functioning button is pressed while the printer is in PictBridge mode.

Remove the PictBridge connection to be able to use the printer for other functions.

Load PLAIN 8.5x11” and press . Or Load PLAIN A4 paper and press .

A paper type other than plain paper is loaded into the paper support when attempting to print an alignment page, a cleaning page, or a network setup page.

Load plain paper, and then press the Select button .

Invalid Proof Sheet. Please reprint the proof sheet and try again.

The printer detects an invalid bar code or an error condition.

Check the proof sheet or reprint the proof sheet. For more information, see Printing Photos Using a Proof Sheet.

Could not detect a proof sheet.

The printer could not recognize the proof sheet, or the proof sheet is skewed or not properly placed on the scanner glass.

Reprint the proof sheet and select your options, or properly place the proof sheet face down on the scanner glass, and scan it again.

No layout selection has been made.

The proof sheet is being scanned without a photo or paper size option selected.

Select a photo or paper size option on the proof sheet, and scan it again.

Only one layout selection can be chosen at a time.

The proof sheet is being scanned with multiple photo or paper size options selected.

Reprint the proof sheet, select only one photo or paper size option, and scan it again.

No images have been selected.

The proof sheet is being scanned without any images selected.

Select images on the proof sheet, and scan it again.

No Proof Sheet information.

The proof sheet is being scanned, and the proof sheet information is deleted or removed from the memory card.

Reprint the proof sheet, select your options, and scan it again.

Some photos removed from card by computer.

A photo selected by the user on the proof sheet has been deleted or removed from the memory card.

Reprint the proof sheet, select your options, and scan it again.

Error NNNN.

If the display shows Error followed by a four-digit number, an advanced error has occurred.

Contact Customer Support. For more information, go to http://support.dell.com/support.
1. Pull the paper firmly to remove it. If you cannot reach the paper because it is too far into the printer, lift the scanner base unit to open the printer.

2. Pull the paper out.

3. Close the scanner base unit.

4. Resend your print job to print any missing pages.

**Paper jam not visible**

1. Turn off the printer.

2. Lift the scanner base unit.

3. Firmly grasp the paper, and gently pull it from the printer.

4. Close the scanner base unit.

5. Turn on the printer, and print the document again.

---

**Avoiding Jams and Misfeeds**

You can avoid most jams and misfeeds by following these guidelines:

- Use media that follows the printer's media guidelines. For more information, see [Loading Paper into the Paper Support](#).
- Make sure that the media is properly loaded in the input tray.
- Do not overload the input tray.
- Do not remove media from the input tray while printing.
- Flex, fan, and straighten the paper before loading.
- Do not use creased, damp, or curled paper.
- Orient the media according to the instructions for the printer.

---

**Paper Problems**

**Make sure you loaded the paper correctly.**

For more information, see [Loading Paper into the Paper Support](#).
Use only paper recommended for your printer.
For more information, see Print Media Guidelines.

Load a smaller amount of paper when printing multiple pages.
For more information, see Print Media Guidelines.

Make sure the paper is not wrinkled, torn, or damaged.

Check for a paper jam.
For more information, see Clearing Paper Jams.

### Printing Problems

**Check the ink levels, and install new print cartridges if necessary.**
For more information, see Replacing Ink Cartridges.

**Ensure that you remove individual sheets from the paper exit tray.**
To avoid ink smudging when you are using the following media, remove each sheet as it exits, and allow it to dry:

- Photo/glossy paper
- Transparencies
- Labels
- Envelopes
- Iron-on transfers

**Free up memory resources on your computer when print speed is slow.**

- Close all applications not in use.
- Try minimizing the number and size of graphics and images in your document.
- Consider purchasing more Random Access Memory (RAM) for your computer.
- Remove fonts that you rarely use from your system.
- Uninstall the printer software, and then reinstall it. For more information, see Removing and Reinstalling Software.
- Select a lower print quality from the Printing Preferences dialog box.

**Ensure that you have loaded the paper correctly.**
For more information, see Loading Paper into the Paper Support.

### Copying Problems
Check for blinking lights or error messages on the printer.
For more information, see Error Messages.

Make sure the scanner glass is clean.
Gently wipe the scanner glass as well as the thin strip of glass beside it with a clean, lint-free cloth dampened with water.

Remove image patterns from magazines or newspapers.
1. In Windows Vista:
   a. Click Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   In Windows XP or Windows 2000:
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

2. Select Dell Imaging Toolbox.
   The Dell Imaging Toolbox dialog box opens.

3. From the Home screen, click My Photo Album.

4. Click File® Open to select the image that you want to edit.

5. With an image open, click the Advanced tab.

6. Click Image Patterns.
   The Image Patterns dialog box opens.

7. Select Remove image patterns from magazine/newspaper (descreen).

8. From the What patterns need to be removed? drop down menu, select a pattern depending on your scanned item.

9. Click OK.

Reduce background noise on scanned documents.
1. In Windows Vista:
   a. Click Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   In Windows XP or Windows 2000:
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

2. Select Dell Imaging Toolbox.
   The Dell Imaging Toolbox dialog box opens.

3. From the Home screen, click My Photo Album.
4. Click **File** ➤ **Open** to select the image that you want to edit.

5. With an image open, click the **Advanced** tab.

6. Click **Image Patterns**.

   The **Image Patterns** dialog box opens.

7. Select **Reduce stray marks (background noise) on color documents**.

8. Move the slider from left to right to adjust the quantity of background noise on your scanned document.

9. Click **OK**.

**Make sure the document or photo is loaded correctly on the scanner glass.**

For more information, see **Loading Original Documents on the Scanner Glass**.

**Check paper sizes.**

Make sure the paper size being used matches the size you selected on the operator panel or the **Dell Imaging Toolbox**.

---

### Scanning Problems

**Check for blinking lights and error messages on the printer.**

For more information, see **Error Messages**.

**Check the USB cable.**

- Ensure the USB cable is firmly connected to your printer and your computer.
- Shut down the computer, reconnect the USB cable as shown on the **Setting Up Your Printer** poster, and then restart the computer.

**Determine if the printer software is installed.**

*In Windows Vista:*

1. Click **Programs**.
2. Click **Dell Printers**.

*In Windows XP or Windows 2000:*

Click **Start** ➤ **Programs** or **All Programs** ➤ **Dell Printers** ➤ **Dell V305**.

If the printer does not appear in the list of printers, the printer software is not installed. Install the printer software. For more information, see **Removing and Reinstalling Software**.

**Correct communication problems between the printer and the computer.**

- Remove and then reconnect the USB cable from your printer and your computer.
- Turn off the printer. Unplug the printer power cable from the electrical outlet. Reconnect the printer power cable into the electrical outlet, and turn on the printer.
- Restart your computer.
Change the scan resolution to a lower value if scanning takes too long or freezes the computer.

1. In Windows Vista:
   a. Click Program.®
   b. Click Dell Printers.
   c. Click Dell V305.

   In Windows XP and Windows 2000:
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

2. Select Dell Imaging Toolbox.

   The Dell Imaging Toolbox dialog box opens.

3. From the Home screen, click Scan.

   The What are you scanning? dialog box opens.

4. Click Custom Settings.

5. From the Scan Resolution drop down menu, select a lower scan resolution.

6. To make this setting the default for all scan jobs, select Always use these settings when scanning.

7. Click Start to start scanning, or click Preview to preview your document or photo before scanning.

---

Change the scan resolution to a higher value if the scanned image quality is poor.

1. In Windows Vista:
   a. Click Program.®
   b. Click Dell Printers.
   c. Click Dell V305.

   In Windows XP and Windows 2000:
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

2. Select Dell Imaging Toolbox.

   The Dell Imaging Toolbox dialog box opens.

3. From the Home screen, click Scan.

   The What are you scanning? dialog box opens.

4. Click Custom Settings.

5. From the Scan Resolution drop down menu, select a higher scan resolution.

6. To make this setting the default for all scan jobs, select Always use these settings when scanning.

7. Click Start to start scanning, or click Preview to preview your document or photo before scanning.

---

Remove image patterns from magazines or newspapers.
1. **In Windows Vista:**
   a. Click ® Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

2. **In Windows XP or Windows 2000:**
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

3. Select **Dell Imaging Toolbox**.
   - The Dell Imaging Toolbox dialog box opens.

4. From the Home screen, click **My Photo Album**.

5. Click File® Open to select the image that you want to edit.

6. With an image open, click the **Advanced** tab.

7. Click **Image Patterns**.
   - The Image Patterns dialog box opens.

8. Select **Remove image patterns from magazine/newspaper (descreen)**.

9. From the What patterns need to be removed? drop down menu, select a pattern depending on your scanned item.

10. Click **OK**.

---

**Reduce background noise on scanned documents.**

1. **In Windows Vista:**
   a. Click ® Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   **In Windows XP or Windows 2000:**
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

2. Select **Dell Imaging Toolbox**.
   - The Dell Imaging Toolbox dialog box opens.

3. From the Home screen, click **My Photo Album**.

4. Click File® Open to select the image that you want to edit.

5. With an image open, click the **Advanced** tab.

6. Click **Image Patterns**.
   - The Image Patterns dialog box opens.

7. Select **Reduce stray marks (background noise) on color documents**.
8. Move the slider from left to right to adjust the quantity of background noise on your scanned document.
9. Click **OK**.

### Make sure the document or photo is loaded correctly on the scanner glass.
For more information, see *Loading Original Documents on the Scanner Glass*.

### Make sure the scanner glass is clean.
Gently wipe the scanner glass, as well as the thin strip of glass beside it, with a clean, lint-free cloth dampened with water.

### Networking Problems

**Check power.**
Ensure that the printer power light is on.

**Check cable.**
- Ensure that the power cable is connected to the printer and to the electrical outlet.
- Ensure that the USB cable is not connected.

**Check your network connection.**
- Ensure that the printer is connected to a working network connection.
- Ensure that the computer is connected to a working network connection before sending a print job.

**Reboot the computer.**
Turn off and restart the computer.

**Check the network adapter documentation for setup and usage information.**

### Memory Card Problems

**Make sure that the type of memory card you are using can be used in the printer.**
For more information, see *Printing From a Memory Card or USB Key*.

**Insert only one memory card at a time.**

**Insert the memory card until it stops.**
The printer will not read the contents of the memory card if it is not properly inserted into the memory card slot.

**When printing images from a memory card, make sure the file format of the images is supported by the printer.**
Only images in JPEG and a limited set of TIFF formats can be printed directly from the memory card. Only TIFF formats created directly from digital still cameras and not modified by any application are supported. If you want to print photos stored on the memory card in a different file format, the photos must be transferred to your computer before printing.

**Make sure the printer is not connected to a PictBridge-enabled camera.**
For more information, see [Printing Photos From a PictBridge-Enabled Camera](#).

---

### Improving Print Quality

If you are not satisfied with the print quality of your documents, there are several different ways to improve the print quality.

- Use the appropriate paper. For example, use Dell™ Premium Photo Paper if you are printing photos with a photo ink cartridge.

- Select a higher print quality.

To select a higher print quality:

1. With your document open, click **File** ➤ **Print**.
   
   The **Print** dialog box opens.

2. Click **Preferences**, **Properties**, **Options**, or **Setup** (depending on the program or operating system).

   The **Printing Preferences** dialog box opens.

3. On the **Print Setup** tab, select a higher quality setting.

4. Print your document again.

5. If the print quality does not improve, try aligning or cleaning the ink cartridges. For more information, see [Aligning Ink Cartridges](#) and [Cleaning the Ink Cartridge Nozzles](#).

   For additional solutions, go to [http://support.dell.com/support](http://support.dell.com/support).

---

### General Guidelines for Selecting or Loading Print Media

- Attempting to print on damp, curled, wrinkled, or torn paper can cause paper jams and poor print quality.

- Use only high-quality, copier-grade paper for the best print quality.

- Avoid paper with embossed lettering, perforations, or a texture that is too smooth or rough. Paper jams may occur.

- Store paper in its packaging until you are ready to use it. Place cartons on pallets or shelves, not on the floor.

- Do not place heavy objects on top of the media, whether or not it is packaged.

- Keep paper away from moisture or other conditions that can cause it to wrinkle or curl.

- Store unused paper at temperatures ranging between 15°C and 30°C (59°F and 86°F). The relative humidity should be between 10% and 70%.

- During storage, you should use moisture-proof wrap, such as a plastic container or bag, to prevent dust and moisture from contaminating the paper.
Printing From a Memory Card or USB Key

- Printing Photos
- Printing Office Files

Most digital cameras use a memory card to store photos. The printer supports the following memory cards:

- Compact Flash Type I and II
- Memory Stick
- Memory Stick PRO
- Memory Stick Duo (with adapter)
- Mini SD (with adapter)
- Microdrive
- Secure Digital
- MultiMedia Card
- xD-Picture Card

Memory cards should be inserted with the label facing up. The card reader has two slots to accommodate these cards and a small light that blinks, indicating the card is being read or is transmitting data.

**NOTE:** Do not insert more than one memory card at a time.

The connector that is used for PictBridge may also be used for accessing information stored on USB keys.

**NOTICE:** Do not remove the memory card or USB key, or touch the printer near the area of the memory card or USB key while actively reading, writing, or printing from these devices. Data corruption can occur.

**NOTE:** Do not insert a USB key if there is already a memory card inserted in the printer.

When you insert a memory card or USB key, the printer automatically switches to Photo mode if it only contains digital photo files. If the memory card or USB key has both documents and photos stored on it, the printer asks the user which file to print. For more information, see Photo Mode.

**NOTE:** The printer supports FAT32 data format. Files stored in NTFS should be converted to FAT32 data format before inserting the memory card or USB key into the printer.

Printing Photos

Saving Photos to Your Computer

1. Insert the memory card or USB key.

   If the memory card or USB key contains photos only, the printer automatically switches to the PHOTO mode.
   
   If the memory card or USB key contains documents and photos, the display asks which files to print. Use the left and right **Arrow** buttons to scroll to Photos, and then press the **Select** button.

2. Use the left and right **Arrow** buttons to scroll to Save Photos, and then press the **Select** button.

3. Press the **Start** button.
The Memory Card Manager is launched on your computer.

4. Follow the instructions on the Memory Card Manager dialog box on how to transfer the photos to your computer.

Printing Photos From a CD or Flash Memory Device

1. Turn on your computer and printer, and ensure that they are connected.

2. Load the paper. For more information, see Loading Paper into the Paper Support.

3. Insert a CD or connect a flash memory device (such as a flash drive, memory card, or digital camera) to the computer, and close any Windows dialogs that appear.

4. In Windows Vista™:
   a. Click ® Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   In Windows XP and Windows 2000:
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

5. Select Dell Imaging Toolbox.

   The Dell Imaging Toolbox dialog box opens.

6. From the Home screen, click My Photo Album.

7. From the Folders pane, browse to the drive that contains your CD or flash memory device, and then open the folder that contains your photos.

   NOTE: If the drive containing your flash memory device does not appear in the Folders pane, close and reopen the software, and then repeat steps 1 through 2.

   Thumbnails of all photos in the folder appear in the preview area.

8. Click to select the photo or photos you want to print.

9. Click Photo Prints.

10. From the drop-down lists, select the print quality, paper size, and paper type settings you want.

11. To select multiple prints of a photo, or to select photo sizes other than 10 x 15 cm (4 x 6 in.), select the options you want in the table. Use the drop-down list in the last column to view and select other sizes.

   NOTE: If you want to edit a photo before printing, click Edit Photo above the Print Preview pane. Select One-Click Auto Fix, Automatic Red-Eye Reduction, or Automatic Brightness Fix to let the software edit your photo automatically. Click More Retouch Tools to go to the photo-editing window. After completing your edits, click Return with edits in the bottom right corner to return to the print window.

12. Click Print Now.

Printing All Photos

1. Insert the memory card or USB key.
If the memory card or USB key contains photos only, the printer automatically switches to the PHOTO mode.

If the memory card or USB key contains documents and photos, the display asks which files to print. Use the left and right Arrow buttons ◀▶ to scroll to Photos, and then press the Select button ➞.

2. Use the left and right Arrow buttons ◀▶ to scroll to Print Images, and then press the Select button ➞ on the operator panel twice.

The printer prints all the photos on the memory card or USB key.

- **NOTE:** If you want to print only some photos on a memory card or USB key, use a proof sheet to select which photos are to be printed. For more information, see Printing Photos Using a Proof Sheet.
- **NOTE:** Only images in JPEG and a limited set of TIFF formats can be printed directly from the memory card or USB key. Only TIFF formats created directly from digital still cameras and not modified by any application are supported. If you want to print photos stored on the memory card or USB key in a different file format, the photos must be transferred to your computer before printing. For more information, see Saving Photos to Your Computer.

### Printing Photos From a Digital Camera Using DPOF

Digital Print Order Format (DPOF) is a feature available on some digital cameras which allows you to store print setting information on a memory card together with the photos that you want to print. Using a DPOF-enabled digital camera, you can specify which photos on the memory card are to be printed, the number of copies to print, and other print settings. The printer recognizes these settings when you insert the memory card into the printer memory card slots.

1. Load photo/glossy paper with the print side facing up.

   - **NOTE:** Make sure the size of the paper loaded is not smaller than the size you specified in the DPOF selection.

2. Insert the memory card. The printer automatically switches to PHOTO mode.

   - **NOTE:** Do not insert more than one memory card or USB key at a time.

3. Use the left and right Arrow buttons ◀▶ to scroll to Print DPOF.

4. Press the Start button ➞.

### Printing Photos Using a Proof Sheet

1. Insert the memory card or USB key.

   If the memory card or USB key contains photos only, the printer automatically switches to PHOTO mode.

   If the memory card or USB key contains documents and photos, the display asks which files to print. Use the left and right Arrow buttons ◀▶ to scroll to Photos, and then press the Select button ➞.

   - **NOTE:** Only images in JPEG and TIFF formats can be printed directly from the memory card or USB key. If you want to print photos stored on the memory card or USB key in a different file format, the photos must be transferred to your computer before printing. For more information, see Saving Photos to Your Computer.

2. Use the left and right Arrow buttons ◀▶ to scroll to Proof Sheet, and then press the Select button ➞.

3. Use the left and right Arrow buttons ◀▶ to scroll to Print Proof Sheet, and then press the Select button ➞.

4. Use the left and right Arrow buttons ◀▶ to specify which photos on the memory card or USB key to print on the proof sheet.

<table>
<thead>
<tr>
<th>You can choose from</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Print all photos on the memory card or USB key on the proof sheet.</td>
</tr>
</tbody>
</table>
5. Press the **Start** button 🔄.

The proof sheet prints.

6. Follow the instructions on the proof sheet to select which photos to print, and to choose a layout and paper type to use.

   Fill in the circle with the red-eye icon below a photo to reduce the red-eye effect on the printout.

   ![Red-eye correction icon](image)

   **NOTE:** Ensure that you completely fill in the circles when making selections.

7. Load the proof sheet face down on the scanner glass. For more information, see [Loading Original Documents on the Scanner Glass](#).

8. Load the paper. For more information, see [Loading Paper into the Paper Support](#).

   **NOTE:** Ensure that the size of the paper you loaded in the printer matches the paper size you specified in the proof sheet.

   **NOTE:** Photo/glossy paper is recommended for printing photos.

9. Use the left and right **Arrow** buttons 👉 to scroll to **Scan Proof Sheet**, and then press the **Start** button 🔄.

---

**Printing Office Files**

1. Turn on your computer and printer, and make sure they are connected.

2. Insert a memory card into a card slot or a USB key into the PictBridge port.

   If the memory card or USB key contains documents only, the printer automatically switches to **OFFICE FILE** mode.

   If the memory card or USB key contains documents and photos, the display asks which files to print. Use the left and right **Arrow** buttons 👉 to scroll to **Documents**, and then press the **Select** button 🔄.

   For information on which file types are supported by your printer, see [Office File Mode](#).

3. Use the left and right **Arrow** buttons 👉 to scroll to the file that you want to print.

4. Press the **Start** button 🔄.
Specifications

- **Overview**
- **Environmental Specifications**
- **Power Consumption and Requirements**
- **Print and Scan Mode Capabilities**
- **Operating System Support**
- **Memory Specifications and Requirements**
- **Media Types and Sizes**
- **Cables**

## Overview

| Memory                  | 32 MB SDRAM  
|                        | 4 MB FLASH  
| Connectivity           | USB 2.0 high-speed  
| Duty cycle (average)   | 3,000 pages per month  
| Printer life           | Printer: 12,000 pages  
|                        | Scanner: 12,000 scans  

## Environmental Specifications

### Temperature/Relative Humidity

<table>
<thead>
<tr>
<th>Condition</th>
<th>Temperature</th>
<th>Relative humidity (non-condensing)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation</td>
<td>60° to 90° F</td>
<td>40 to 80%</td>
</tr>
<tr>
<td>Storage</td>
<td>34° to 140° F</td>
<td>5 to 80%</td>
</tr>
<tr>
<td>Shipping</td>
<td>-40° to 140° F</td>
<td>5 to 100%</td>
</tr>
</tbody>
</table>

## Power Consumption and Requirements

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated AC input</td>
<td>100 to 240 V</td>
</tr>
<tr>
<td>Rated frequency</td>
<td>50 Hz / 60 Hz</td>
</tr>
<tr>
<td>Minimum AC input</td>
<td>90 VAC</td>
</tr>
<tr>
<td>Maximum AC input</td>
<td>255 VAC</td>
</tr>
<tr>
<td>Maximum input current</td>
<td>0.6 A</td>
</tr>
<tr>
<td>Average power consumption</td>
<td></td>
</tr>
</tbody>
</table>
Print and Scan Mode Capabilities

Your printer can scan from 72 to 19,200 dpi. Although your printer has this capability, Dell™ recommends using the preset resolutions.

<table>
<thead>
<tr>
<th>Print and scan resolution</th>
<th>Scan resolution</th>
<th>Print resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Photo/Glossy paper</td>
</tr>
<tr>
<td>Draft</td>
<td>150 x 150 dpi</td>
<td>600 x 600 dpi</td>
</tr>
<tr>
<td>Normal</td>
<td>300 x 300 dpi</td>
<td>1200 x 1200 dpi</td>
</tr>
<tr>
<td>Photo</td>
<td>600 x 600 dpi (photo and mono scan)</td>
<td>4800 x 1200 dpi</td>
</tr>
<tr>
<td></td>
<td>300 x 300 dpi (color scan)</td>
<td></td>
</tr>
</tbody>
</table>

Operating System Support

The printer supports:

- Windows Vista™
- Microsoft® Windows® XP Professional x64
- Microsoft Windows XP
- Microsoft Windows 2000

Memory Specifications and Requirements

Your operating system must meet the minimum system requirements.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Processor speed (MHz)</th>
<th>RAM (MB)</th>
<th>Hard disk (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista</td>
<td>AMD Athlon 3400+ 2.19 GHz</td>
<td>256</td>
<td>800</td>
</tr>
<tr>
<td>Microsoft Windows XP Professional x64</td>
<td>AMD Athlon 3400+ 2.19 GHz</td>
<td>256</td>
<td>800</td>
</tr>
<tr>
<td>Microsoft Windows XP</td>
<td>Pentium II 300</td>
<td>256</td>
<td>800</td>
</tr>
<tr>
<td>Microsoft Windows 2000</td>
<td>Pentium II 233</td>
<td>128</td>
<td>800</td>
</tr>
</tbody>
</table>

Media Types and Sizes

<table>
<thead>
<tr>
<th>Media type:</th>
<th>Sizes supported:</th>
<th>Load up to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper or coated paper</td>
<td>Letter: 8.5 x 11 inches (216 x 279 mm) A4: 8.27 x 11.69 inches (210 x 297 mm) Legal: 8.5 x 14 inches (216 x 355.6 mm)</td>
<td>100 sheets</td>
</tr>
</tbody>
</table>
### Banner paper
- A4 Banner
- Letter Banner

<table>
<thead>
<tr>
<th>Envelopes</th>
<th>20 sheets</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 Envelopes: 3 7/8 x 8 7/8 inches</td>
<td>10 envelopes</td>
</tr>
<tr>
<td>10 Envelopes: 4 1/8 x 9 1/2 inches</td>
<td></td>
</tr>
<tr>
<td>Baronial 5 1/2 Envelopes: 4 3/8 x 5 3/4 inches</td>
<td></td>
</tr>
<tr>
<td>6 3/4 Envelopes: 3 1/4 x 6 1/2 inches</td>
<td></td>
</tr>
<tr>
<td>7 3/4 Envelopes: 3 7/8 x 7 1/2 inches</td>
<td></td>
</tr>
<tr>
<td>A2 Baronial Envelopes: 111 x 146 mm</td>
<td></td>
</tr>
<tr>
<td>B5 Envelopes: 176 x 250 mm</td>
<td></td>
</tr>
<tr>
<td>C5 Envelopes: 162 x 229 mm</td>
<td></td>
</tr>
<tr>
<td>C6 Envelopes: 114 x 162 mm</td>
<td></td>
</tr>
<tr>
<td>DL Envelopes: 110 x 220 mm</td>
<td></td>
</tr>
<tr>
<td>Chokei 3 Envelopes: 120 x 235 mm</td>
<td></td>
</tr>
<tr>
<td>Chokei 4 Envelopes: 90 x 205 mm</td>
<td></td>
</tr>
<tr>
<td>Chokei 40 Envelopes: 90 x 225 mm</td>
<td></td>
</tr>
<tr>
<td>Kakugata 3 Envelopes: 216 x 277 mm</td>
<td></td>
</tr>
<tr>
<td>Kakugata 4 Envelopes: 197 x 267 mm</td>
<td></td>
</tr>
<tr>
<td>Kakugata 5 Envelopes: 190 x 240 mm</td>
<td></td>
</tr>
<tr>
<td>Kakugata 6 Envelopes: 162 x 229 mm</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Greeting cards, index cards, postcards, or photo cards</th>
<th>25 cards</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo/Post card: 4 x 6 inches</td>
<td></td>
</tr>
<tr>
<td>Index card: 3 x 5 inches</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Photo/glossy or matte paper</th>
<th>25 sheets</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.5 x 11 inches (216 x 279 mm)</td>
<td></td>
</tr>
<tr>
<td>A4: 8.27 x 11.69 inches (210 x 297 mm)</td>
<td></td>
</tr>
<tr>
<td>4 x 6 inches (101.6 x 152.4 mm)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Iron-on transfers</th>
<th>10 iron-on transfers</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.5 x 11 inches (216 x 279 mm)</td>
<td></td>
</tr>
<tr>
<td>A4: 8.27 x 11.69 inches (210 x 297 mm)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transparencies</th>
<th>50 transparencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.5 x 11 inches (216 x 279 mm)</td>
<td></td>
</tr>
<tr>
<td>A4: 8.27 x 11.69 inches (210 x 297 mm)</td>
<td></td>
</tr>
</tbody>
</table>

---

**Cables**

Your printer uses a Universal Serial Bus (USB) cable (sold separately).
Copying

- Copying Documents
- Copying Photos

Copying Documents

Using the Operator Panel

1. Turn on the printer.
2. Load the paper. For more information, see Loading Paper into the Paper Support.
3. Load your original document.
4. Use the Arrow buttons to scroll to the COPY mode, and then press the Select button.
5. Use the Arrow buttons to scroll through the copy submenus and change the copy settings. For more information, see Copy Mode.
6. Press the Start button.

**NOTE:** If you press the Start button without changing the copy settings from the copy submenus, the copy is printed in the current default settings.

Using Your Computer

1. Turn on your computer and printer, and ensure that they are connected.
2. Load the paper. For more information, see Loading Paper into the Paper Support.
3. Load your original document. For more information, see Loading Original Documents on the Scanner Glass.
4. In Windows Vista™:
   a. Click Programs.
   b. Click Dell Printers.
c. Click **Dell V305**.

*In Windows® XP or Windows 2000:*

Click **Start Programs** or **All Programs Dell Printers Dell V305**.

5. Select **Dell Imaging Toolbox**.

The **Dell Imaging Toolbox** dialog box opens.

6. From the **Home** screen, click **Copy**.

The **What are you scanning?** dialog box opens.

7. Select **Document**.

8. Click **Custom Settings** if you want to adjust how your document will be scanned before creating a copy or copies.

9. Click **Start**.

The document appears in the right pane of the **Copy** dialog box.

10. On the left pane of the **Copy** dialog box, select the copy settings that you want.

11. Click **Copy Now**.

---

### Copying Photos

#### Using the Operator Panel

1. Turn on the printer.

2. Load the paper.

3. Load your original document.

4. From the **Copy Quality** submenu, select **Photo**.

5. Press the **Start** button.

---

**Using Your Computer**
1. Turn on your computer and printer, and ensure that they are connected.

2. Load photo/glossy paper with the print side facing up. If you want to copy a 4 x 6 photo, load a 4 x 6 (10 x 15 cm) photo card with the print side facing up. For more information, see Loading Paper into the Paper Support.

3. Load your original photo on the scanner glass. For more information, see Loading Original Documents on the Scanner Glass.

4. In Windows Vista:
   a. Click Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   In Windows XP or Windows 2000:
   Click Start Programs or All Programs Dell Printers Dell V305.

5. Select Dell Imaging Toolbox.

   The Dell Imaging Toolbox dialog box opens.

6. From the Home screen, click Copy.

   The What are you scanning? dialog box opens.

7. Select Photo.

8. Click Custom Settings if you want to adjust how your document will be scanned before creating a copy or copies.

9. Click Start.

   The photo appears in the right pane of the Copy dialog box.

10. From the drop-down lists, select the print quality, paper size, and paper type settings that you want.

11. To select multiple prints of a photo, or to select photo sizes other than 10 x 15 cm (4 x 6 in.), select the options you want in the table. Use the drop-down list in the last column to view and select other sizes.

12. Click Copy Now.
Appendix

- Dell Technical Support Policy
- Contacting Dell
- Warranty and Return Policy
- Wireless Regulatory Information

Dell Technical Support Policy

Technician-assisted technical support requires the cooperation and participation of the customer in the troubleshooting process and provides for restoration of the Operating System, application software and hardware drivers to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality of the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical support is available at Dell Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for third-party software and peripherals is provided by the original manufacturer, including those purchased and/or installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus).

Contacting Dell

You can access Dell Support at support.dell.com. Select your region on the WELCOME TO DELL SUPPORT page, and fill in the requested details to access help tools and information.

You can contact Dell electronically using the following addresses:

- World Wide Web
  - www.dell.com/
  - www.dell.com/ap/ (Asian/Pacific countries only)
  - www.dell.com/ip/ (Japan only)
  - www.euro.dell.com (Europe only)
  - www.dell.com/la/ (Latin American and Caribbean countries)
  - www.dell.ca (Canada only)

- Anonymous file transfer protocol (FTP)
  - ftp.dell.com
    Log in as user: anonymous, and use your email address as your password.

- Electronic Support Service
  - mobile_support@us.dell.com
  - support@us.dell.com
  - la-techsupport@dell.com (Latin America and Caribbean countries only)
  - apsupport@dell.com (Asian/Pacific countries only)
  - support.jp.dell.com (Japan only)
  - support.euro.dell.com (Europe only)
Warranty and Return Policy

Dell Inc. ("Dell") manufactures its hardware products from parts and components that are new or equivalent to new in accordance with industry-standard practices. For information about the Dell warranty for your printer, refer to the Product Information Guide.

Wireless Regulatory Information

Wireless Interoperability

The Dell Wireless Printer Adapter products are designed to be interoperable with any wireless LAN product that is based on direct sequence spread spectrum (DSSS) radio technology to comply with the following standards:

- IEEE 802.11b-1999 Standard on 2.4 GHz Wireless LAN
- IEEE 802.11g Standard on 2.4 GHz Wireless LAN
- Wireless Fidelity (Wi-Fi) certification, as defined by the WECA (Wireless Ethernet Compatibility Alliance)

Warranty and Return Policy

The Dell Wireless Printer Adapter, like other radio devices, emits radio frequency electromagnetic energy. The level of energy emitted by this device, however, is less than the electromagnetic energy emitted by other wireless devices such as mobile phones. The Dell Wireless Printer Adapter operates within the guidelines found in radio frequency safety standards and recommendations. These standards and recommendations reflect the consensus of the scientific community and result from deliberations of panels and committees of scientists who continually review and interpret the extensive research literature. In some situations or environments, the use of the Dell Wireless Printer Adapter may be restricted by the proprietor of the building or responsible representatives of the applicable organization.

Examples of such situations include the following:

- Using the Dell Wireless Printer Adapter equipment on board airplanes, or
- Using the Dell Wireless Printer Adapter equipment in any other environment where the risk of interference with other devices or services is perceived or identified as being harmful.

If you are uncertain of the policy that applies to the use of wireless devices in a specific organization or environment (an airport, for example), you are encouraged to ask for authorization to use the Dell Wireless Printer Adapter device before you turn it on.

⚠️ CAUTION: Explosive Device Proximity Warning: Do not operate a portable transmitter (such as a wireless network device) near unshielded blasting caps or in an explosive environment unless the device has been modified to be qualified for such use.

⚠️ CAUTION: Use On Aircraft Caution: Regulations of the FCC and FAA prohibit airborne operation of radio-frequency wireless devices because their signals could interfere with critical aircraft instruments

Regulatory Information

The Dell Wireless Printer Adapter must be installed and used in strict accordance with the manufacturer’s instructions as described in the user documentation that comes with the product. For country-specific approvals, see "Radio Approvals". Dell Inc is not responsible for any radio or television interference caused by unauthorized modification of the devices.
Radio Frequency Interference Requirements

**CAUTION:** This device is restricted to indoor use due to its operation in the 2.412 GHz to 2.462 GHz frequency range. The FCC requires this product to be used indoors for the frequency range 2.412 GHz to 2.462 GHz to reduce the potential for harmful interference to co-channel Mobile Satellite systems.

**Interference Statement**

These devices comply with Part 15 of the FCC Rules. Operation of the devices is subject to the following two conditions: (1) The devices may not cause harmful interference, and (2) The devices must accept any interference that may cause undesired operation. This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy. If the equipment is not installed and used in accordance with the instructions, the equipment may cause harmful interference to radio communications. There is no guarantee, however, that such interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception (which can be determined by turning the equipment off and on), the user is encouraged to try to correct the interference by taking one or more of the following measures:

- Relocate this device.
- Increase the separation between the device and the receiver.
- Connect the device into an outlet on a circuit different from that of other electronics.
- Consult the dealer or an experienced radio technician for help.

**NOTE:** This Dell Wireless Printer Adapter must be installed and used in strict accordance with the manufacturer’s instructions as described in the user documentation that comes with the product. Any other installation or use will violate FCC Part 15 regulations. Modifications not expressly approved by Dell could void your authority to operate the equipment.

This device must not be co-located or operating in conjunction with any other antenna or transmitter.
Scanning Single-Page Documents and Single Photos

Using the Operator Panel

1. Turn on your computer and printer, and ensure that they are connected. If you want to scan over the network, ensure that your printer is connected to the network.

2. Load your original document. For more information, see Loading Original Documents on the Scanner Glass.

3. Use the left and right Arrow buttons \(\langle\rangle\) to scroll to SCAN, and then press the Select button \(\checkmark\).

4. Use the left and right Arrow buttons \(\langle\rangle\) to scroll to Scan To Computer, and then press the Select button \(\checkmark\).

5. If your printer is connected using a USB cable:
   a. The printer downloads the application list from the computer.
      
      Use the left and right Arrow buttons \(\langle\rangle\) to scroll through the available applications to which your scan can be sent.
      
   b. When the application you want to use appears on the display, press the Select button \(\checkmark\).

   If your printer is connected to a network:

   a. Use the left and right Arrow buttons \(\langle\rangle\) to scroll through the available computers to which your scan can be sent.

   b. When the computer you want to use appears on the display, press the Select button \(\checkmark\).

   c. If the computer has a PIN associated with it, use the keypad to enter the four-digit PIN.

   \(\text{NOTE:}\) The PIN is not required by default; it is only required if the computer you want to send your scan to has a PIN set. You can view or change the PIN or the name of the computer to which you want to send your scan. For more information, see Setting the Computer Name and PIN.

   d. Press the Select button \(\checkmark\).

6. Press the Start button \(\checkmark\).

The printer scans the page. When the scan is complete, a file is created in the selected application.
Using Your Computer

1. Turn on your computer and printer, and ensure that they are connected.

2. Load your original document or photo facedown on the scanner glass. For more information, see Loading Original Documents on the Scanner Glass.

3. In Windows Vista™:
   a. Click Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

In Windows® XP or Windows 2000:
Click Start ® Programs or All Programs ® Dell Printers ® Dell V305.

4. Select Dell Imaging Toolbox.
The Dell Imaging Toolbox dialog box opens.

5. From the Home screen, click Scan.
The What are you scanning? dialog box opens.

6. Select the Photo option.
If you want to scan a document without changing the text, and you do not want to make a PDF, selecting the Photo option scans the document as an image and sends it to the Library instead of your default word-processing application.

7. Click Start.

Setting the Computer Name and PIN

Specify a name for your computer to enable you to locate it on the Host Selection screen when scanning across a network. If you want to restrict users from sending a scanned document to your computer, set a scan-to-network Personal Identification Number (PIN).

1. In Windows Vista:
   a. Click Control Panel.
   b. Click Hardware and Sound.
   c. Click Printers.

In Windows XP, click Start ® Settings ® Control Panel ® Printers and Other Hardware ® Printers and Faxes.
In Windows 2000, click Start ® Settings ® Printers.

2. Right-click your printer icon, and then click Printing Preferences.
The Printing Preferences dialog box opens.

3. From the Maintenance tab, click Network Support.
The Dell Networking Options dialog box opens.
4. From the **Dell Networking Options** dialog box, click **Change your PC name and PIN for network scanning**.

5. Follow the instructions on the screen.

6. After you specify a computer name or a PIN, click **OK**.

---

**Scanning Multiple Photos Into a Single File**

*NOTE:* Some programs do not support multiple-page scanning.

1. Turn on your computer and printer, and ensure that they are connected.

2. Load your original photos on the scanner glass. For more information, see [Loading Original Documents on the Scanner Glass](#).

   *NOTE:* For best results, leave the most space possible between the photos and the edges of the scan area.

3. In **Windows Vista**:
   a. Click ® **Programs**.
   b. Click **Dell Printers**.
   c. Click **Dell V305**.

   *In Windows XP and Windows 2000:*  
   Click **Start** ® **Programs** or **All Programs** ® **Dell Printers** ® **Dell V305**.

4. Select **Dell Imaging Toolbox**.

   The **Dell Imaging Toolbox** opens.

5. From the **Home** screen, click **Scan Multiple Photos**.

6. Click **Start**.

---

**Scanning Documents for Editing**

The **Optical Character Recognition (OCR)** feature turns a scanned document into text that you can edit with a word-processing application.

*NOTE:* For customers using Japanese or Simplified Chinese, ensure that you have OCR software installed on your computer. A copy of OCR software is provided with your printer and should have been installed on your computer along with your printer software.

1. Turn on your computer and printer, and ensure that they are connected.

2. Load your original document facedown on the scanner glass. For more information, see [Loading Original Documents on the Scanner Glass](#).

3. In **Windows Vista**:
   a. Click ® **Programs**.
   b. Click **Dell Printers**.
   c. Click **Dell V305**.
In Windows XP and Windows 2000:
Click Start® Programs or All Programs® Dell Printers® Dell V305.

4. Select Dell Imaging Toolbox.

The Dell Imaging Toolbox opens.

5. From the Home screen, click Activities.

6. Click Convert Scanned Document to Text (OCR).

7. Click Start.

The scanned document is loaded into your default word-processing application. You can now edit the document.

---

**Scanning Photos for Editing**

1. Turn on your computer and printer, and ensure that they are connected.

2. Load your original photo facedown on the scanner glass. For more information, see [Loading Original Documents on the Scanner Glass](#).

3. **In Windows Vista:**
   a. Click Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   **In Windows XP and Windows 2000:**
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

4. Select Dell Imaging Toolbox.

   The Dell Imaging Toolbox opens.

5. From the Home screen, click Activities.

6. Click Edit Picture.

7. Select the Photo or Several Photos option.

8. Click Start.

   The image appears in the Save or Edit dialog box.

9. Select editing options from the left pane to edit your photos.

---

**Saving Photos on Your Computer**

1. Turn on your computer and printer, and ensure that they are connected.

2. Load your original photo or multiple photos face down on the scanner glass. For more information, see [Loading Original Documents on the Scanner Glass](#).

   **NOTE:** For best results, leave the most space possible between the photos and the edges of the scan area.
3. **In Windows Vista:**
   
   a. Click ® Programs.
   
   b. Click Dell Printers.
   
   c. Click Dell V305.

   **In Windows XP and Windows 2000:**
   
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

4. Select Dell Imaging Toolbox.
   
   The Dell Imaging Toolbox opens.

5. From the Home screen, click Scan.

6. Select the Photo or Several Photos option.

7. Click Start.

8. From the right pane of the Save or Edit dialog box, click Save.

9. To change how the image is saved:
   
   a. Select one or more of the following:
      
      - To save to another folder, click Browse, select a folder, and then click OK.
      - To rename the file, type the name in the File Name area.
      - To save the photo as another file type, select the file type from the File Type drop down list.
      - To select a date for the photo, click the drop-down list, and select a date from the calendar.
   
   b. Click Save.

---

### Resizing Images or Documents

1. Turn on your computer and printer, and ensure that they are connected.

2. **In Windows Vista:**
   
   a. Click ® Programs.
   
   b. Click Dell Printers.
   
   c. Click Dell V305.

   **In Windows XP and Windows 2000:**
   
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

3. Select Dell Imaging Toolbox.
   
   The Dell Imaging Toolbox opens.

4. From the Home screen, click Activities.

5. Click Resize a Scanned Image.
6. If you are scanning a new image:
   a. Click **File**® **New**® **Scan New Image**.
   b. Select from the **Photo** option.
   c. Click **Start**.
      The thumbnail of the scanned image appears in the right pane of the **Library** dialog box.
   d. Select the photo that you want to resize.

If you are using a saved image:
   a. From the **Folders** pane in the **Library** dialog box, open the folder that contains the file that you want to resize.
      The thumbnails of all photos and documents in the folder appear in the preview area.
   b. Select the photo that you want to resize.

7. Click **Next**.
   The **Image Resolution/Size** dialog box opens.

8. Select the size of your new image using the preset photo sizes, or set your own custom size.

9. Click **OK**.

---

**E-Mailing Documents or Photos**

**Scanning Documents or Photos for E-Mailing**

You can scan documents or photos, and attach them to e-mail messages.

1. Turn on your computer and printer, and ensure that they are connected.

2. Load your original document or photo facedown on the scanner glass. For more information, see Loading Original Documents on the Scanner Glass.

3. In Windows Vista:
   a. Click ® **Programs**.
   b. Click **Dell Printers**.
   c. Click **Dell V305**.

   In Windows XP and Windows 2000:
   Click **Start**® **Programs** or **All Programs**® **Dell Printers**® **Dell V305**.

4. Select **Dell Imaging Toolbox**.
   The **Dell Imaging Toolbox** opens.

5. From the **Home** screen, click **Scan**.

6. Select the **Photo** or **Several Photos** option.
7. Click **Start**.

The scanned image appears in the right pane of the **Save or Edit** dialog.

8. Adjust your scanned image using the settings on the left pane of the **Save or Edit** dialog box.

9. Save your scanned image.

10. With your scanned item selected, click **E-mail**.

11. From the **Send Quality and Speed** area, select the photo size.

12. Click **Create E-mail** to attach your document or photo to an e-mail message.

### Adding a File to an E-mail Message

1. **In Windows Vista:**
   - a. Click ® **Programs**.
   - b. Click **Dell Printers**.
   - c. Click **Dell V305**.

   **In Windows XP and Windows 2000:**
   - Click **Start® Programs** or **All Programs® Dell Printers® Dell V305**.

2. Select **Dell Imaging Toolbox**.

   The **Dell Imaging Toolbox** dialog box opens.

3. From the **Home** screen, click **My Photo Album**.

4. From the **Folders** pane, open the folder that contains the files you want to send.

   Thumbnails of all photos and documents in the folder appear in the preview area.

5. Click to select each photo or document that you want to add, and then click **E-mail**.

6. If you are sending one or more photos, select a photo size.

7. Click **Create E-mail** to create an e-mail message with your file attached.

### Creating a PDF

#### From a Scanned Item

1. Load an original document facedown on the scanner glass.

2. **In Windows Vista:**
   - a. Click ® **Programs**.
b. Click **Dell Printers**.

c. Click **Dell V305**.

*In Windows XP and Windows 2000:*

Click **Start**® **Programs** or **All Programs**® **Dell Printers**® **Dell V305**.

3. Select **Dell Imaging Toolbox**.

   The **Dell Imaging Toolbox** dialog box opens.

4. From the **Home** screen, click **My Photo Album**.

5. Click **Add**, and then click **Add New Scan**.

6. Select **Photo**, **Several Photos**, or **Document**.

7. Click **Start** to begin scanning.

8. With your scan selected, click **Convert to PDF**.

9. Click **Add Another** to scan additional images or to add an image from the Library.

10. To add or scan another image:

    a. Do one of the following:

       * Select **Add New Scan**, and then select **Photo**, **Several Photos**, or **Document**. Click **Start**.
       
       * Select **Add Photo from Library** to add a previously scanned image, and then select or deselect images by clicking on them in the preview pane.

    b. Click **Add Files** when you have made your selections.

11. Select **Save all images as one PDF file** or **Save each image as individual PDF file**.

12. Click **Create PDF**.

   The software prepares your PDF and opens a **Save** dialog box.

13. Type a file name for your PDF, and select a storage location.

14. Click **Save**.

### From a Saved Item

1. **In Windows Vista:**

    a. Click **Programs**.

    b. Click **Dell Printers**.

    c. Click **Dell V305**.

*In Windows XP and Windows 2000:*

Click **Start**® **Programs** or **All Programs**® **Dell Printers**® **Dell V305**.

2. Select **Dell Imaging Toolbox**.

   The **Dell Imaging Toolbox** dialog box opens.
3. From the Home screen, click My Photo Album.

4. From the Folders pane, open the folder that contains the image you want to convert to PDF, and then select the thumbnail.

5. Click Convert to PDF.

6. Click Add Another to scan an image or to add additional images from the Library.

7. To add or scan another image:
   a. Do one of the following:
      - Select Add New Scan, and then select Photo, Several Photos, or Document. Click Start.
      - Select Add Photo from Library, and then select or deselect images by clicking on them in the preview pane.
   b. Click Add Files when you have made your selections.

8. Select Save all images as one PDF file or Save each image as individual PDF file.

9. Click Create PDF.

   The software prepares your PDF and opens a Save dialog box.

10. Enter a file name for your PDF, and select a storage location.

11. Click Save.

---

Customizing Scan Settings

1. In Windows Vista:
   a. Click ® Programs.
   b. Click Dell Printers.
   c. Click Dell V305.

   In Windows XP and Windows 2000:
   Click Start® Programs or All Programs® Dell Printers® Dell V305.

2. Select Dell Imaging Toolbox.

   The Dell Imaging Toolbox dialog box opens.

3. From the Home screen, click Scan.

4. Click Custom Settings.

5. Change the settings as needed.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Depth</td>
<td>Select Color, Gray, or Black and White.</td>
</tr>
<tr>
<td>Scan Resolution (Dots Per Inch)</td>
<td>Select a scan resolution value from the drop-down list.</td>
</tr>
<tr>
<td>Size</td>
<td>• Auto-crop the scanned item.</td>
</tr>
<tr>
<td></td>
<td>• Select the area to be scanned by selecting a paper size from the drop-down list.</td>
</tr>
</tbody>
</table>
## Changing the Scan Settings Preferences

1. **In Windows Vista:**
   a. Click “Programs.
   b. Click “Dell Printers.
   c. Click “Dell V305.

   **In Windows XP and Windows 2000:**
   Click “Start ” Programs or “All Programs ” Dell Printers ” Dell V305.

2. Select **Dell Imaging Toolbox**.
   
   The **Dell Imaging Toolbox** dialog box opens.

3. From the **Home** screen, click **Settings**, and then click **Toolbox Settings**.

4. Click **Scan Settings**.
   
   - Select **Always use simple scan settings** to use the default scan settings.
   - Select **Always start scanning with the settings below** to customize the remaining scan settings.
   - From the **Color Depth** area, select the color depth from the list.
   - From the **Scan Resolution (Dots per inch)** area, select the resolution value from the list.
   - Click **Auto-crop the scanned item** to use the slider to select your cropped value.
   - Click **Select area to be scanned** to select the value from the list.
   - Click **Convert images to text with OCR** to convert images to text.

5. Click **OK**.

<table>
<thead>
<tr>
<th>Convert the image to text with OCR</th>
<th>Convert an image to text.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always use these settings when scanning</td>
<td>Make your selections permanent by selecting the check box.</td>
</tr>
</tbody>
</table>
Licensing Notice

- BSD License and Warranty statements
- GNU License

The printer resident software contains:

- Software developed and copyrighted by Dell and/or third parties
- Dell modified software licensed under the provisions of the GNU General Public License version 2 and the GNU Lesser General Public License version 2.1
- Software licensed under the BSD license and warranty statements
- Software based in part on the work of the Independent JPEG Group.

The Dell modified GNU licensed software is free software; you can redistribute it and/or modify it under the terms of the licenses referenced above. These licenses do not provide you any rights to the Dell- or third-party-copyrighted software in this printer.

Since the GNU licensed software that the Dell modifications are based upon is supplied explicitly without warranty, use of the Dell modified version is similarly provided without warranty. See the warranty disclaimers in the referenced licenses for additional details.

---

BSD License and Warranty statements

Copyright (c) 1991 The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. The name of the author may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR `AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---

GNU License

GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users. This General Public License applies to most of the Free Software Foundation's software and to any other program whose authors commit to using it. (Some other Free Software Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands that there is no warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to know that what they have is not the original, so that any problems introduced by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

GNU GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed under the terms of this General Public License. The "Program", below, refers to any such program or work, and a "work based on the Program" means either the Program or any derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into another language. (Hereinafter, translation is included without limitation in the term "modification".) Each licensee is addressed as "you". Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running the Program is not restricted, and the output from the Program is covered only if its contents constitute a work based on the Program (independent of having been made by running the Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.

c. If the modified program normally reads commands interactively when run, you must cause it, when started running for such interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may redistribute the program under these conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself is interactive but does not normally print such an announcement, your work based on the Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Program, and can be reasonably considered independent and separate works in themselves, then this License, and its
terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

a. Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

b. Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

c. Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative is allowed only for noncommercial distribution and only if you received the program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable work, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the executable. However, as a special exception, the source code distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place counts as distribution of the source code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system, which is implemented by public license practices. Many people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Program under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.
9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which applies to it and "any later version", you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Program does not specify a version number of this License, you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to make it free software which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively convey the exclusion of warranty; and each file should have at least the "copyright" line and a pointer to where the full notice is found.

1 April 1989
Lexmark International, Inc.

This General Public License does not permit incorporating your program into proprietary programs. If your program is a subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this is what you want to do, use the GNU Library General Public License instead of this License.

GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999
Copyright (C) 1991, 1999 Free Software Foundation, Inc.
59 Temple Place, Suite 330, Boston, MA 02111-1307 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and change free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries--of the Free Software Foundation and other authors who decide to use it. You can use it too, but we suggest you first think carefully about whether this license or the ordinary General Public License is the better strategy to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish); that you receive source code or can get it if you want it; that you can change the software and use pieces of it in new free programs; and that you are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender these rights. These restrictions translate to certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that we gave you. You must make sure that they, too, receive or can get the source code. If you link other code with the library, you must provide complete object files to the recipients, so that they can relink them with the library after making changes to the library and recompiling it. And you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which gives you legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the library is modified by someone else and passed on, the recipients should know that what they have is not the original version, so that the original author’s reputation will not be affected by problems that might be introduced by others.

Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company cannot effectively restrict the users of a free program by obtaining a restrictive license from a patent holder. Therefore, we insist that any patent license obtained for a version of the library must be consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license, the GNU Lesser General Public License, applies to certain designated libraries, and is quite different from the ordinary General Public License. We use this license for certain libraries in order to permit linking those libraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally speaking a combined work, a derivative of the original library. The ordinary General Public License therefore permits such linking only if the entire combination fits its criteria of freedom. The Lesser General Public License permits more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to protect the user's freedom than the ordinary General Public License. It also provides other free software developers Less of an advantage over competing non-free programs. These disadvantages are the reason we use the ordinary General Public License for many libraries. However, the Lesser license provides advantages in certain special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so that it becomes a de-facto standard. To achieve this, non-free programs must be allowed to use the library. A more frequent case is that a free library does the same job as widely used non-free libraries. In this case, there is little to gain by limiting the free library to free software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large body of free software. For example, permission to use the GNU C Library in non-free programs enables many more people to use the whole GNU operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that the user of a program that is linked with the Library has the freedom and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between a "work based on the library" and a "work that uses the library". The former contains code derived from the library, whereas the latter must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright holder or other authorized party saying it may be distributed under the terms of this Lesser General Public License (also called "this License"). Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be conveniently linked with application programs (which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work which has been distributed under these terms. A "work based on the Library" means either the Library or any derivative work under copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly into another language. (Hereinafter, translation is included without limitation in the term "modification").

"Source code" for a work means the preferred form of the work for making modifications to it. For a library, complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The
act of running a program using the Library is not restricted, and output from such a program is covered only if its contents constitute a work based on the Library (independent of the use of the Library in a tool for writing it). Whether that is true depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a. The modified work must itself be a software library.

b. You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.

c. You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

d. If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that uses the facility, other than as an argument passed when the facility is invoked, then you must make a good faith effort to ensure that, in the event an application does not supply such function or table, the facility still operates, and performs whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the application. Therefore, Subsection 2d requires that any application-supplied function or table used by this function must be optional: if the application does not supply it, the square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Library, and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General Public License, version 2, instead of to this License. (If a newer version than version 2 of the ordinary GNU General Public License has appeared, then you can specify that version instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place satisfies the requirement to distribute the source code, even though third parties are not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled or linked with it, is called a "work that uses the Library". Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable that is a derivative of the Library (because it contains portions of the Library), rather than a "work that uses the library". The executable is therefore covered by this License. Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file that is part of the Library, the object code for the work may be a derivative work of the Library even though the source code is not. Whether this is true is especially significant if the work can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined by law.
If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of Section 6. Any executables containing that work also fall under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that uses the Library" with the Library to produce a work containing portions of the Library, and distribute that work under terms of your choice, provided that the terms permit modification of the work for the customer's own use and reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are covered by this License. You must supply a copy of this License. If the work during execution displays copyright notices, you must include the copyright notice for the Library among them, as well as a reference directing the user to the copy of this License. Also, you must do one of these things:

a. Accompany the work with the complete corresponding machine-readable source code for the Library including whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is an executable linked with the Library, with the complete machine-readable "work that uses the Library", as object code and/or source code, so that the user can modify the Library and then relink to produce a modified executable containing the modified Library. (It is understood that the user who changes the contents of definitions files in the Library will not necessarily be able to recompile the application to use the modified definitions.)

b. Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time a copy of the library already present on the user's computer system, rather than copying library functions into the executable, and (2) will operate properly with a modified version of the library, if the user installs one, as long as the modified version is interface-compatible with the version that the work was made with.

c. Accompany the work with a written offer, valid for at least three years, to give the same user materials needed for reproducing the executable from it. However, as a special exception, the materials to be distributed need not include anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally accompany the operating system. Such a contradiction means you cannot use both them and the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library facilities not covered by this License, and distribute such a combined library, provided that the separate distribution of the work based on the Library and of the other library facilities is otherwise permitted, and provided that you do these two things:

a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities. This must be distributed under the terms of the Sections above.

b. Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate your rights under this License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from the original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties with this License.
11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Library at all. For example, if a patent license would not permit royalty-free redistribution of the Library by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply, and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system which is implemented by public license practices. Many people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places the Library under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns. Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies to it and “any later version”, you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Library does not specify a license version number, you may choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with these, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the public, we recommend making it free software that everyone can redistribute and change. You can do so by permitting redistribution under these terms (or, alternatively, under the terms of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It is safest to attach them to the start of each source file to most effectively convey the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is found.

1 April 1990

Lexmark International, Inc.

That's all there is to it!